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КУРС ЛЕКЦИЙ 

 

РАЗДЕЛ V. СОЗДАНИЕ МАКЕТА ИНТЕРАКТИВНОГО ПОРТФОЛИО 

(V СЕМЕСТР) 

 

Тема 1. Типы презентаций. 

 

1. Линейные презентации.  

2. Нелинейные презентации.  

3. Циклические презентации.  

4. Смешанные презентации.  

 

В мире каждый день происходит огромное число презентаций. К ним относятся 

презентации новых компаний, продуктов, различных программ (культурных, 

социальных, предвыборных) и т. д. На сегодняшний день презентации являются 

наиболее востребованным продуктом. 

В настоящее время существует несколько классификаций презентаций. Н.И. 

Дворко делит их следующим образом: 

• Торговые мобильные мультимедийные презентации, предназначенные для 

использования торговыми агентами при заключении сделок. Позволяют за короткое 

время предоставить всю информацию о товаре и тем самым значительно сократить 

время на заключение сделки. 

• Маркетинговые презентации, содержащие основные сведения о приоритетных 

направлениях деятельности компании и продукции, которую она выпускает. Это 

телевизионная реклама. В одной презентации объединяется графика, анимация, видео и 

звук. Они предназначены для широкой аудитории и проводятся либо на выставках-

ярмарках, либо непосредственно в офисе клиента. 

• Обучающие презентации, предназначенные для помощи преподавателю и 

позволяющие удобно и наглядно представить учебный материал. При их ис-

пользовании самые сложные темы можно преподнести так, что учащиеся будут 

усваивать материал без труда и с интересом. 

Если презентации делить по способу предоставления информации, то это 

деление будет выглядеть следующим образом: 

• линейные; 

• нелинейные; 

• циклические; 

• смешанные. 

Остановимся на последнем делении презентаций и рассмотрим особенности 

каждого типа в отдельности, а также рассмотрим, какие факторы в рамках этих 

презентаций влияют на успех. 

 

Линейные презентации 

 
Схематический рисунок линейных презентаций 

 

Особенностью данной презентации является то, что ею управляет докладчик и 

последовательность кадров жестко определена. 

В линейной презентации слайды сменяют друг друга по команде выступающего 

(по щелчку), иногда это происходит быстро, иногда медленно, все зависит от 

докладчика. 
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Такие презентации встречаются чаще всего на конференциях по какой-либо 

тематике, собраниях акционеров и т. д. Основная информация доклада содержится в 

речи докладчика, и лишь иногда, в качестве иллюстрации своих слов, он обращается к 

содержимому кадра на экране. Кадры при этом сменяют друг друга по его команде. 

Порой докладчик зачитывает какие-либо данные с экрана, а порой просто обращает 

внимание слушателей на тот или иной график, таблицу и т. д. 

В зависимости от сферы применения линейных презентаций они делятся на: 

1. Управленческие - различные предложения по дальнейшему развитию 

компании, результаты управления, новые идеи, проекты; 

2. Коммерческие —  предложение новых продуктов компаний (они возможны и 

в циклической форме); 

3. Научные — представляются (учеными) научные идеи для привлечения 

ресурсов на исследования; 

4. Рекламные (в т. ч. паблик рилейшнз) —  продвигаются новые стратегии 

компаний и новые бренды, представляются культурные и социальные программы для 

поиска дополнительного финансирования и поддержки. 

5. Общественно-политические —  выступление с различными избирательными 

программами, пресс-конференции, «круглые столы». 

Презентации данного типа удобно создавать в MS PowerPoint. Однако создание 

с помощью любой другой программы тоже не составит труда. 

 

Нелинейные презентации 

 
Схематический рисунок нелинейных презентаций 

 

Нелинейная презентация реализуется в рамках некоторой информационной 

компьютерной среды (например, Интернет, локальная сеть и т. д.). В отличие от 

линейных презентаций в нелинейных презентациях последовательность подачи 

материала не определена. Докладчик в этом случае отсутствует и зритель сам 

выбирает, что ему интересно. Поэтому необходимо предусмотреть систему навигации, 

так как в данном случае отдельных кадров может и не быть: вместо них появятся 

области экрана, в которые загрузится вызванная пользователем информация, например 

разновидность товара. Система навигации должна быть интуитивно понятна любому 

пользователю. Внутренняя структура такой презентации гораздо сложнее. 

Данные презентации готовятся для CD-визиток (представление фирмы), 

расширенного каталога фирмы, систем оплаты товаров и услуг (например, оплата за 

мобильные телефоны через удаленные терминалы). 

Подобные презентации можно создавать как в традиционной для данной области 

программе MS PowerPoint, так и в Macromedia Flash, Macromedia Director или в любом 

HTML-редакторе. 
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Циклические презентации. 

 
Кроме описанных вариантов существует третий вариант презентаций - 

презентация-видеоролик, или циклическая презентация (например, телевизионная 

реклама). 

В данном случае ни о каком управлении последовательностью кадров речи не 

идет: ролик просто «крутится» независимо от оператора. 

Это может быть либо «настоящее» видео, отснятое на камеру и смонтированное, 

а может быть просто циклический ролик любого (из описанных выше) типа 

презентаций. Почти аналогичным образом устроены ролики для световых панно, 

реклама на телевидении. 

При создании циклической презентации используются разнообразные 

технические средства (видеокамеры, видеомагнитофоны, аудиооборудование и т. д.) и 

компьютерные программы (MS PowerPoint, Macromedia Flash, Macromedia Director, 

программы для видеомонтажа). 

 

Смешанные презентации 

Особняком стоят смешанные презентации, например, предназначенные для 

выставок, а также сайтов сети Интернет. Здесь могут встречаться почти все возможные 

виды презентаций. 

Большое количество сайтов сети Интернет сегодня представляют собой 

смешанную презентацию, в которую входят как нелинейные, так и циклические пре-

зентации в различных вариантах. 

Встречаются варианты выставочных презентаций, когда заинтересовавшийся 

посетитель может выбрать для себя «путь просмотра». На выставочных докладах и 

семинарах используется слайд-шоу. 

Для создания смешанных презентаций используется тот же инструментарий, что 

и для других презентаций. 

Итак, презентации бывают в виде: 

• линейных презентаций, в виде линейной последовательности слайдов; 

• нелинейных презентаций, в виде разветвленной структуры вроде гипертекста; 

• циклических презентаций, в виде видеоролика, слайд-шоу; 

• выставочных (смешанных) презентаций. 

В настоящее время для создания презентаций используется целый ряд 

аппаратных и программных средств, таких, как MS PowerPoint,  Adobe InDesign и т.д. 

Они позволяет создавать как линейные, так и разветвленные презентации с 

гиперссылками, подключать звук, видео и различные виды графики. 

 

Контрольные вопросы: 

1. Что представляет собой смешанные презентации? 

2. Какие существуют классификации презентаций? 

3. На какие типы делятся презентации? 

4. Что представляет собой линейная презентация? 

5. Что представляет собой нелинейная презентация? 
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6. Что представляет собой циклическая презентация? 

 

Литература: [1— С. 10-17; 2 — С. 14-9; 3 — С.95-98; 83-85] 

 

 Тема2. Работа с интерактивными документами. 

 

1. Создание нового интерактивного документа.  

2. Использование палитры Buttons and Forms.  

3. Создание интерактивных закладок и текстовых ссылок.  

4. Создание интерактивных гиперссылок.   

5. Использование палитры Hyperlinks. 

 

Теоретические сведения об интерактивных документах 

Давайте приступим к работе и начнем с того, что разберемся, что же такое 

интерактивный документ. Интерактивный документ представляет собой файл, 

предназначенный не для печати, а для просмотра на экране электронного устройства. В 

этом и заключается его главное отличие. В Adobe InDesign CS6 у нас есть возможность 

создавать интерактивные публикации двух видов — для экспорта в Interactive PDF и 

для Adobe Flash. По сути, интерактивность внутри самого проекта InDesign интересует 

нас в меньшей степени, т. к. у большинства пользователей просто не установлен пакет 

InDesign, поэтому у них нет возможности просматривать файлы с расширением indd. 

Альтернативные же форматы, предложенные нам для экспорта публикаций, являются 

массовыми и доступными для любого пользователя. 

Когда мы будем работать уже непосредственно с инструментами для создания 

интерактивных элементов, вы обратите внимание, что они бывают трех видов — либо 

универсальные, либо созданные для PDF, либо предназначенные для Flash. Данное 

разделение обусловлено только тем, что стандарты, используемые для экспорта, 

слишком разные, и каждый по отдельности не поддерживает все возможные функции. 

В принципе, это, пожалуй, и вся теоретическая информация, которую пока что 

нужно понимать. А теперь давайте приступать к практике. 

 

Создание нового интерактивного документа 

Каким же образом InDesign "понимает", что ведется работа не над простым 

печатным, а именно над интерактивным документом? Здесь все предельно просто и 

определяется уже на этапе создания нового документа. Давайте разберемся с этим 

процессом подробней. 

Итак, для того чтобы создать новый интерактивный документ, выберите в 

главном меню InDesign пункт File > New > Document. 

Как вы видите, по умолчанию в раскрывающемся списке Intent (назначение 

документа) указано Print (рис. 1.1). При этом все единицы измерения в полях для 

управления шириной, высотой, отступами, полями и прочими параметрами задаются в 

пунктах или миллиметрах, в зависимости от того, как настроен ваш интерфейс. Если же 

мы в раскрывающемся списке Intent выберем режим Web (рис. 1.2), то все значения 

автоматически будут переведены в пикселы. Здесь также присутствует другое 

назначение документа — Digital Publishing. 

 

http://lib.lgaki.info/page_lib.php?docid=15256&mode=DocBibRecord
http://lib.lgaki.info/page_lib.php?docid=35232&mode=DocBibRecord
http://lib.lgaki.info/page_lib.php?docid=35291&mode=DocBibRecord


5 

 

 
 

Рис. 1.1. Диалоговое окно New Document 

 

 
 

Рис. 1.2. Выбор режима Web в диалоговом окне New Document 

 

Кроме того, в раскрывающемся списке Page Size появились совершенно иные 

варианты предустановок (рис. 1.3). Это происходит из-за того, что в случае с 

интерактивными публикациями размеры дисплея конечного устройства в связке с его 

разрешающими способностями измеряются в пикселах, следовательно, и макет и все 

элементы внутри него должны быть описаны в данных единицах. 

 

 
 

Рис. 1.3. Варианты установок в раскрывающемся  

списке Page Size при выборе режима Web 

 

Еще одно важное изменение, которое происходит при создании нового 

документа при установленном назначении Web, — это наборы параметров в палитре 

Swatches (Window > Color > Swatches). Как вы наверняка знаете, они представлены в 

режиме работы с печатными документами в цветовой модели CMYK (рис. 1.4, слева). 
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При выбранном же значении Web в раскрывающемся списке Intent в палитре Swatches 

все цвета будут преобразованы в цветовую модель RGB (см. рис. 1.4, справа). 

 

 
 

Рис. 1.4. Вид палитры Swatches при выборе режима Print (слева) и Web (справа) 

 

Это происходит по той же причине, что и в предыдущем случае — экраны всех 

устройств излучают свет и в своей работе регулируются моделью RGB. Именно из-за 

этого макет и создается в этой модели. В продолжение нашего разговора, если мы 

вернемся к диалоговому окну создания нового документа, здесь осталось еще два 

момента, на которые обязательно стоит обратить внимание. Во-первых, при создании 

интерактивных документов не стоит выбирать опцию Facing Pages. Она отвечает за 

отображение страниц в виде разворотов. Немного позже вы увидите, что в случае с 

интерактивными документами это не имеет значения, т. к. экран в один момент может 

отображать только одну страницу заданного размера. Следовательно, верстка 

разворотами нецелесообразна. 

Второй важный элемент — наличие или отсутствие полей у интерактивного 

документа. Если вернуться к тому, для чего изначально создавались обязательные поля 

в мире печати, то мы должны вспомнить о том, что это было вызвано 

технологическими особенностями печати и погрешностями при резке. В мире 

электронных публикаций данных ограничений нет, и мы можем задать точное 

положение объекта на листе вплоть до пиксела и, соответственно, на экране конечного 

устройства. При этом, как вы понимаете, всякая необходимость в специальном 

определении полей и вылетов пропадает. Однако вы вполне можете использовать эти 

направляющие для реализации собственных дизайнерских задумок. 

Наконец, самое важное, что нужно знать при создании нового документа, — это 

размеры и разрешение экрана конечного устройства, на котором будет просматриваться 

электронная публикация. Она должна быть создана именно в этих размерах и для этого 

разрешения, на то есть ряд причин. Во-первых, соблюдение пропорций экрана позволит 

документу занимать его целиком, что избавит пользователя от созерцания черных 

пустых полос сбоку, сверху или снизу от него. Во-вторых, изображения будут 

помещены в публикацию с корректным разрешением, и пользователь сможет 

просматривать их в великолепном качестве. Мы еще не раз вернемся к этой теме в 

следующих разделах и главах этой книги. А пока просто каждый раз при создании 

нового интерактивного документа бxcxcудьте предельно сосредоточены и обращайте 

внимание на все описанные нюансы. Этим вы сможете заложить уверенный фундамент 

для всей своей дальнейшей работы. 

 

Создание интерактивных закладок и текстовых ссылок 

В данном разделе будет рассмотрено, как создавать и управлять различными 

видами закладок в документе InDesign CS6. В качестве примера для работы следует 
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использовать файл Sample_work.indd, который находится в папке \Интерактивность в 

рабочих материалов (ссылка на электронный архив в списке литературы). Данный 

документ представляет собой портфолио некоего фотографа, занимающегося 

пейзажной съемкой в экзотических странах. Мы будем работать с данным материалом 

на протяжении всей этой главы, постепенно наращивая для него возможности, которые 

предоставляет интерактивный функционал пакета Adobe InDesign CS6. 

В одном из прошлых разделов мы упомянули, что существует несколько 

вариантов для экспорта готового интерактивного документа. Во-первых, в виде 

Interactive PDF; во-вторых, как Flash-публикацию в двух различных форматах — SWF и 

FLA. 

В первую очередь в данном разделе мы познакомимся с функциями, которые 

позволяет нам использовать интерактивная версия формата PDF. Первая из таких 

функций — это внедрение закладок. Закладки представляют собой структурное 

упорядочение итогового PDF-документа, состоящего из большого количества разделов. 

Мы можем видеть PDF-закладки, в зависимости от используемого программного 

обеспечения для чтения файлов, либо в специализированной панели 

Bookmarks, расположенной в левой половине окна просмотра стандартной 

программы Adobe Acrobat Reader (рис. 1.5), либо в панелях с другими наименованиями 

в прочих системах воспроизведения PDF. 

 

 
 

Рис. 1.5. Вид панели Bookmarks программы Adobe Acrobat Reader 

 

Данные закладки можно использовать двумя различными способами. Во-

первых, они, как классическое оглавление в любой книге, дают нам информацию о том, 

на какой странице начинается тот или иной раздел публикации. Кроме того, закладки 

являются ссылками, по нажатию на которые пользователь может переходить 

непосредственно к интересующей его части документа. 

Немаловажным является факт, что закладки могут быть ссылками как на начало 

целой главы или раздела, так и на внутренние подразделы или параграфы. Кроме того, 

для большей наглядности, практически в любой программе для просмотра PDF-

документов поддерживается отображение вложенности закладок относительно друг 

друга (рис. 1.6). 
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Рис. 1.6. Отображение вложенности в панели Bookmarks 

 

Например, если у нас есть ссылка на вторую главу какой-либо книги и ссылка на 

пятый параграф этой главы, то в дереве наших ссылок мы увидим структуру, 

напоминающую лестницу, в которой каждый вложенный раздел будет визуально 

немного смещен относительно родительского. В большинстве программ просмотра 

также поддерживается организация данных закладок по уровням вложенности, т. е. с 

помощью ряда кнопок в иерархической структуре мы можем свернуть все дерево для 

отображения только глав, можем "войти" внутрь структуры какой-то конкретной главы, 

не "раскрывая" дерево остальных глав, и т. д. Систему закладок данного вида впредь 

будем называть внешним оглавлением. 

Другой вид закладок, систему которых мы будем называть внутренним 

оглавлением, строится несколько по другим принципам. Они не зависят от программы, 

в которой производится чтение, и представляют собой фактическое оглавление, 

внедренное внутрь издания, занимающее определенное количество страниц и не 

требующее открытия дополнительных панелей (рис. 1.7). Данный вид закладок может 

иметь собственное оформление, стили и, вместе с тем, обладать все тем же рядом 

функций, что и внешнее оглавление, т. е. определение фактического номера страницы, 

соответствующего началу раздела, и ссылочный переход к нему по нажатию на текст 

закладки. 

Для генерации обоих видов оглавления нам достаточно зайти в пункт меню 

Layout > Table of Contents программы InDesign, создать с помощью классических 

стилей оглавление и не забыть установить флажок Create PDF Bookmarks. После этого 

у нас есть две возможности. Мы можем либо поместить наше оглавление внутрь 

публикации и получить внутреннее оглавление, либо не помещать и, соответственно, 

автоматически получить внешнее. Как вы видите, ничего сложного здесь нет. Однако, 

кроме пункта меню Table of Contents, в пакете InDesign CS6 есть и другие инструменты 

для работы с закладками. 
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Рис. 1.7. Внутреннее оглавление в документе PDF 

 

В нашем примере мы не будем генерировать внутреннее или внешнее 

многоступенчатое оглавление, а используем закладки для немного других целей. Для 

этого, в первую очередь, откроем панель Bookmarks. Запомните, что закладки — это не 

что иное, как простые ссылки на информацию внутри файла. Предположим, что мы 

хотим создать систему закладок, переводящих нас на каждую из страниц нашего 

документа. В нашем примере присутствует обложка, страница с вводной информацией, 

страница с галереей и ряд страниц с обзором представленных работ. Для создания 

новой закладки на конкретную страницу публикации необходимо выделить эту 

страницу и, открыв палитру Bookmarks c помощью пункта главного меню Window > 

Interactive > Bookmarks, нажать в нижней ее части кнопку New Bookmark. 

После этого программа предлагает нам задать имя для вновь созданной закладки  

(рис. 1.8). Так как мы выбрали для создания страницу-обложку, назовем закладку 

Cover. Выделим следующую страницу, повторим операцию, нажав кнопку New 

Bookmark, и назовем новую закладку Introduction. Так же создадим еще одну закладку 

для страницы с галереей, присвоив ей имя Gallery, и одну для первой представленной 

работы с именем Work 01. 

Итак, мы получили систему навигации, состоящую из четырех закладок. В 

первую очередь, их уже можно использовать для навигации по документу, просто 

дважды нажимая на название каждой. Обратите внимание на то, что рядом с именем 

закладки присутствует значок в виде страницы (рис. 1.9). Это означает, что данная 

закладка направляет пользователя на конкретную страницу документа. Кроме этого, мы 

можем создавать закладки на другие типы навигационной информации. 

К примеру, создадим закладку, ссылающуюся на отрывок текста. Для этого 

выберите на панели инструментов инструмент Type Tool и установите курсор в любое 

место среди текстовых блоков внутри публикации. После этого, повторив действие из 

предыдущего примера, нажмите кнопку New Bookmark. Точно так же, как и раньше, 

создается новая закладка с предложением ввести для нее имя; в нашем случае не 

принципиально, какое имя вы ей дадите. Акцентируйте ваше внимание на том, что, в 

отличие от предыдущих примеров, значок рядом с названием новой закладки по форме 

напоминает якорь (см. рис. 1.9). 
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Рис. 1.8. Вид панели Bookmarks при создании новой закладки 

 

 
 

Рис. 1.9. Вид панели Bookmarks со всеми созданными закладками 
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Причина, по которой это происходит, кроется в том, что в данном случае 

InDesign создает закладку типа Text Anchor или текстовый якорь. Чтобы понять, что он 

собой представляет, в первую очередь давайте выйдем из режима презентации путем 

выбора пункта меню View > Screen Mode > Normal или нажатием горячей клавиши 

<W>. После этого перейдем к пункту меню Type > Show Hidden Characters (горячие 

клавиши <Alt>+<Ctrl>+<I>). Теперь в том месте, где вы установили текстовый якорь, 

вы можете видеть символ, похожий на двоеточие. Он означает, что в данном месте 

установлен Text Anchor. Таким образом, данные якоря являются, посути, пунктами 

назначения для ссылок, которые формируются с помощью палитры Bookmarks. 

Стоит обратить внимание на то, что не только простое установление курсора в 

определенном месте текстового массива может позволить создать текстовый якорь. 

Такую же возможность дает выделение фрагмента текста с последующим нажатием 

кнопки New Bookmark. Несомненным плюсом такого способа создания якорей является 

тот факт, что им автоматически при создании присваиваются имена согласно 

выделенным фрагментам текста. 

Итак, мы создали ряд закладок, ссылающихся на различные разделы нашего 

документа. Обратите внимание на тот факт, что два текстовых якоря, созданные нами в 

последнюю очередь, физически относятся к первому разделу — Introduction, — и 

находятся на первой странице нашей публикации, для которой мы ранее создали 

отдельную закладку. Вспомните про систему вложенности ссылок, о которой мы 

говорили ранее в этом разделе. Давайте организуем нашу систему закладок, чтобы 

добиться подобного эффекта. Для этого нужно щелкнуть мышью по названию 

имеющегося якоря и "перетащить" его на имя раздела, к которому он относится. После 

этого мы увидим рядом с корневой закладкой значок вложенности, щелкнув на 

который отобразятся элементы, находящиеся по структуре внутри данного элемента, в 

нашем случае текстовый якорь, ранее туда помещенный. 

Для того чтобы устранить вложенность того или иного элемента в нашей 

публикации, необходимо точно так же щелкнуть по нему мышью и "вытащить" из 

другой закладки. При дальнейшем перемещении элемента вы увидите, что в 

определенных местах появляется жирная линия, наглядно отображающая, в какое 

место в итоговой иерархии попадет перемещаемый элемент (рис. 1.10). 

 

 
 

Рис. 1.10. Вид панели Bookmarks с настроенной системой вложенности 
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Еще один способ создания вложенных закладок заключается в том, что мы 

можем выделить нужную нам главную закладку и, после выделения фрагмента текста и 

нажатия кнопки New Bookmark, можно получить текстовый якорь, который будет сразу 

же вложен в выбранную старшую закладку. 

Для удаления какой-либо закладки достаточно выделить ее и нажать на значок 

мусорного ведра в правом нижнем углу панели Bookmarks. В зависимости от настроек 

может появиться информационное окно, сообщающее пользователю о невозвратности 

этого действия и запрашивающее о дальнейших действиях. Если вы уверены в том, что 

хотите удалить выбранную закладку, то нажмите кнопку OK. 

Если же вы передумали, нажмите кнопку Cancel.  

 

Создание интерактивных гиперссылок 

В прошлом разделе мы изучили методы создания и управления поведением 

интерактивных закладок и текстовых ссылок. В данном же разделе, как логическое 

продолжение прошлого, мы продолжим работать с уже знакомым нам файлом 

портфолио и научимся создавать гиперссылки внутри интерактивного документа 

InDesign. Когда речь заходит о гиперссылках, у большинства людей в голове возникает 

ассоциация с адресной строкой браузера с адресом для перехода в сети Интернет. 

Однако спектр применения гиперссылок значительно шире, в чем вы в 

ближайшее время сами сможете убедиться. Давайте обратимся к специально 

разработанной для этого панели инструментов Hyperlinks (гиперссылки), которую 

можно вызвать из меню Window > Interactive > Hyperlinks (рис. 1.11). 

Как вы видите, данная панель разделена на два смысловых блока — Hyperlinks и 

Cross-References (перекрестные ссылки). Перекрестные ссылки — это один из 

инструментов создания интерактивности, но он необходим больше для работы с 

объемными документами, такими как, например, книги. С ними мы ближе 

познакомимся в следующей главе, когда будем говорить про создание макетов 

публикаций в формате ePub. Сейчас же давайте обратим наше внимание на блок 

Hyperlinks этой панели. 

 

 
 

Рис. 1.11. Вид панели Hyperlinks 

 

Для гиперссылок в InDesign CS6 существует два типа данных, с которыми они 

могут работать, — это так называемые данные об источнике и данные о назначении. 
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Давайте разберемся с двумя этими типами данных на примере. Для этого перейдем к 

странице 4 нашей презентации. Обратите внимание на боковую панель в правой части 

нашего макета. 

В ее верхнем разделе есть информация о клиенте — его название, web-сайт, имя 

проекта и дата его реализации. Если мы захотим превратить адрес из статичной 

текстовой надписи в гиперссылку таким образом, чтобы по ней можно было перейти на 

сайт, сама надпись www.polylab.org станет источником; непосредственно же сайт 

www.polylab.org, открытый в браузере, станет, в этом случае, пунктом назначения. 

Держа это принципиальное отличие в голове, рассмотрим несколько типовых 

подходов к работе с гиперссылками. Во-первых, мы можем, перемещаясь по всему 

нашему документу, на каждый встречающийся адрес одновременно задавать данные и 

об источнике и о назначении. Или же мы можем изначально указать программе 

InDesign информацию обо всех пунктах назначения, на которые могут указывать 

ссылки в документе. Давайте рассмотрим это на примере. 

Для этого обратимся к контекстному меню панели Hyperlinks и выберем в нем 

пункт New Hyperlink Destination (обратите внимание, что предварительно выделять в 

документе ничего не нужно). 

 

 
 

Рис. 1.12. Вид окна New Hyperlink Destination при выбранном типе ссылки Page 

 

Открывается одноименное диалоговое окно (рис. 1.12), в котором мы можем 

настроить ряд параметров для назначения ссылки. Первый параметр это его тип (Type) 

— по умолчанию он выбран как Page, т. е. страница в текущем документе. 

Для данного типа имеются два базовых параметра для настройки — номер 

страницы, которая станет назначением (Page), и настройки масштабирования (Zoom 

Setting). Сразу же обращаю ваше внимание на то, что настройки масштабирования 

актуальны только при сохранении в PDF-документе и будут игнорироваться при 

использовании технологии Flash. Также здесь есть опция (флажок) Name with Page 

Number, отвечающая за автоматическое присвоение имени вида ""Page + № 

страницы"" вашему пункту назначения. Соответственно, если данная опция отключена, 

вы можете свободно назначить ему любое имя. 

Второй тип назначения ссылки — Text anchor или текстовый якорь. Как вы 

видите, он сейчас не активен; о нем мы поговорим немного позже. Сейчас же 

рассмотрим третий тип — URL (рис. 1.13). 
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Рис. 1.13. Вид окна New Hyperlink Destination при выбранном типе ссылки URL 

 

URL расшифровывается как Uniform Resource Locator (единый указатель 

ресурсов) и является стандартизированным способом записи адреса ресурса в сети 

Интернет, или, проще говоря, привычным для нас адресом сайта вида 

http://www.site.ru/. Именно с этой информацией работает данный тип назначения 

ссылки. После выбора этого типа нам предоставляется всего два поля для заполнения. 

Давайте зададим имя нашему первому пункту назначения, пускай это будет MySite, в 

строке URL пропишем адрес назначения, к примеру, http://www.polylab.org/. После 

этого нажмите кнопку OK. Как вы видите, ничего не изменилось, но теперь, если вы 

выберете в контекстном меню нашей панели Hyperlink Destination Options, то вы 

увидите в раскрывающемся списке Destination диалогового окна Hyperlink Destination 

Options вновь созданное назначение ссылки (рис. 1.14). 

 

 
 

Рис. 1.14. Вид диалогового окна Hyperlink Destination Options 

 

Теперь мы имеем возможность привязывать любое количество источников 

ссылки в нашем документе к созданному пункту назначения. В этом же диалоговом 

окне мы имеем возможность удалять различные ранее созданные пункты назначения, 

либо выбирая их по одному и нажимая кнопку Delete, либо же можем удалить их все 

сразу, нажав кнопку Delete All; также, при нажатии кнопки Edit, диалоговое окно 

предоставляет возможность редактировать созданные пункты назначения. Для того 

чтобы выйти из этого диалогового окна без изменений, нажмем кнопку Cancel. 

Теперь, когда у нас все готово, давайте создадим нашу первую интерактивную 

гиперссылку. Первым способом создания ссылки, как вы уже знаете, является 

одновременное определение и источника и назначения. На боковой панели нашего 

документа выделим часть текста "www.polylab.org". Обратите внимание, что теперь в 

панели Hyperlinks стало доступным для заполнения поле URL. Для осуществления 

этого способа просто введите в это поле адрес, к примеру, http://www.polylab.org/ (рис. 

1.15) и нажмите на клавиатуре клавишу <Enter>. 
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Рис. 1.15. Создание новой интерактивной ссылки (первый способ) 

 

Вторым способом, как вы помните, является привязка источника к уже 

созданному назначению. Для этого необходимо в поле URL нажать кнопку открытия 

раскрывающегося списка и в нем выбрать созданный ранее пункт назначения (рис. 

1.16), после чего на клавиатуре также нажать клавишу <Enter>. Кроме того, есть еще 

один способ создания ссылок, к тому же, дающий нам возможность настроить ряд 

важных параметров. Для того чтобы это сделать, выделите любой другой фрагмент 

текста и нажмите кнопку Create New Hyperlink в нижней части панели. По нажатию 

открывается соответствующее диалоговое окно New Hyperlink. В первую очередь, 

обратим внимание на верхнюю часть этого окна (рис. 1.17). Первый раскрывающийся 

список Link To указывает на то, с чем будет связана ссылка, по умолчанию здесь 

указывается Shared Destination и это значит, что назначением для данной ссылки будет 

служить ранее созданный нами пункт, который можно выбрать в раскрывающемся 

списке Name. 
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Рис. 1.16. Создание новой интерактивной ссылки (второй способ) 

 

 
 

Рис. 1.17. Вид диалогового окна New Hyperlink 

 

Это, пожалуй, самый сложный для понимания момент в области гиперссылок. 

Казалось бы, для чего нужно придумывать лишнюю "прослойку" между источником 

ссылки и назначением в виде адреса. Для того чтобы это понять, давайте представим 

ситуацию, когда мы создаем 100-страничный документ, на каждой странице которого в 

том или ином месте указывается ссылка на сайт одной и той же компании в виде "Моя 

Компания". По нажатию на это имя подразумевается, что у пользователя открывается 

браузер, в адресной строке которого уже указано http://www.mycompany.com/. В 

процессе создания документа вы создали 100 однотипных ссылок на один и тот же 

сайт. И все, казалось бы, хорошо, но в последний день заказчик решил изменить адрес 

сайта, куда будет идти ссылка, к примеру, на такой 

http://www.mycompany.com/advertising.html/, и поместить там информацию о какой-

либо акции. Согласитесь, не такой уж и редкий случай. А теперь представьте, сколько 

времени потребуется на изменение всех этих ссылок. К счастью, InDesign предлагает 

нам уникальную модель работы со ссылками. Это и есть уже знакомые вам Hyperlink 

Destinations. В чем же отличие? В случае работы с ними, мы бы один раз создали пункт 

назначения http://www.mycompany.com/ и при создании ссылок просто привязывали бы 

абсолютно любые источники вида "Моя Компания", "Компания", "О компании" и т. д. к 
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созданному назначению ссылки. А теперь, внимание, в тот момент, когда заказчик 

решил изменить адрес сайта, просто заходим в пункт контекстного меню Hyperlink 

Destination Options палитры Hyperlinks и меняем адрес. Все наши ссылки, т. к. они вели 

на сайт не на прямую, а через условную "прослойку" в виде назначения ссылки, 

автоматически снова становятся правильными. Вот и весь фокус. 

Теперь, когда нам стало понятно, что такое Shared Destination, вернемся к 

диалоговому окну New Hyperlink. Раскрывающийся список Document позволяет нам 

выбрать назначение ссылки не только из документа, с которым мы работаем, но также 

из любого ранее созданного документа. Это дает возможность работать над достаточно 

сложными мультимедийными проектами, состоящими их двух и более документов. 

Теперь обратимся к нижней части этого диалогового окна (см. рис. 1.17). Во 

первых, в раскрывающемся списке Style нам предоставляется возможность выбрать 

стиль для внешнего вида ссылки — давайте выберем URL (он был заранее подготовлен 

в палитре Character). Самая нижняя группа элементов данного диалогового окна 

называется Appearance и отвечает за внешний вид ссылки, но не в рабочем файле 

InDesign, а в окончательной публикации в программе просмотра PDF-документов, 

такой как, к примеру, Adobe Acrobat Reader. Список Type дает возможность выбрать, 

будет ли видна (Visible Rectangle) или скрыта (Invisible Rectangle) зона 

чувствительности в форме прямоугольника вокруг ссылки. Список Highlight указывает, 

как ссылка будет "подсвечена", т. е. выделена в тексте — подчеркиванием, 

инвертированным цветом либо полужирным начертанием; с помощью опции None 

можно отключить изменение выделения, что мы и сделаем (рекомендуется всегда 

оставлять настройки внешнего представления в состоянии, которое мы только что 

настроили, т. к. они работают только на уровне программы просмотра и могут 

нарушить те дизайнерские свойства, которые мы внедряем в InDesign). После всех 

изменений нажмем кнопку OK. В нашем документе произошло два принципиальных 

изменения. Во-первых, как вы видите, изменился цвет ссылки. Это произошло потому, 

что мы задали определенный стиль для внешнего представления ссылок ("URL"). Во-

вторых, в палитре Hyperlinks появилась новая ссылка. Чтобы внести какие-либо 

изменения в данную конкретную ссылку, все, что нам нужно сделать, — это дважды 

щелкнуть по ней в палитре. Откроется диалоговое окно Edit Hyperlink, внешне ничем 

не отличающееся от знакомого нам окна создания новой ссылки. Для того чтобы 

закрыть его без изменений, нажмем кнопку Cancel. Обратите также внимание на две 

кнопки в виде стрелок внизу палитры Hyperlinks. Нажатие на левую приводит нас к 

источнику ссылки, нажатие же на правую — к открытию браузера на адресе нашего 

пункта назначения. 

Давайте создадим еще несколько ссылок. Если мы перейдем на пятую страницу 

нашей публикации, то увидим слева похожую панель с данными о клиенте. Давайте 

снова выделим адрес сайта www.polylab.org, нажмем внизу палитры Hyperlinks кнопку 

New Hyperlink, но на этот раз в раскрывающемся списке Link To выберем уже другой 

тип ссылки — URL (рис. 1.18). В данном случае мы можем создать прямую ссылку на 

сайт. 
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Рис. 1.18. Вид диалогового окна New Hyperlink в режиме URL 

 

Однако обратите внимание на опцию Shared Hyperlink Destination в группе 

элементов Destination. В случае если она выбрана вместе со ссылкой, на основе ее 

данных будет создан также пункт назначения, который, в последующем, можно будет 

использовать при создании новых ссылок. Если же эту опцию отключить, будет 

создана обычная ссылка без привязки к пункту назначения и с возможными 

трудностями, о которых говорилось выше. 

Как резюме, можно отметить, что, если вы создаете хотя бы две ссылки, идущие 

к одному и тому же пункту назначения (дальше мы поймем, что им может быть не 

только сайт), настоятельно рекомендуется использовать Shared Hyperlink Destination. В 

случае же "одноразового" использования ссылки, вполне допустимо и даже 

рекомендуется обходиться без создания дополнительного назначения. 

Рассмотрим дополнительные виды ссылок, которые InDesign позволяет нам 

создать (рис. 1.19). Первый из них — File — дает возможность по нажатию на ссылку 

осуществлять открытие заранее заданного файла. Необходимо помнить, что в случае, 

если выбранный файл требует специального программного обеспечения для открытия, 

он будет открыт в своем "родном" приложении, за которым он закреплен на 

пользовательском компьютере. К сожалению, InDesign не предоставляет нам 

возможность принудительно определить, каким приложением будет открываться файл. 

 

 
 

Рис. 1.19. Типы поддерживаемых ссылок 

 

Следующий тип ссылки — Email — определяет ссылки на почтовые адреса. Еще 

один тип — Page — дает нам возможность определять страницу в документе, на 
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которую будет осуществляться переход. Причем не только в документе, с которым мы 

работаем в настоящий момент, но и в любом другом выбранном проекте. 

Последний тип ссылок, которые можно создавать — Text Anchor, — текстовые 

якоря. Обратите внимание на то, что если мы создаем данный вид ссылки впервые, в 

выпадающем меню Text Anchor вы ничего не обнаружите. Давайте создадим новый 

текстовый якорь и посмотрим, для чего они необходимы. Для этого закроем диалоговое 

окно New Hyperlink, нажав кнопку Cancel, и выделим какой-либо фрагмент текста в 

нашем документе, к примеру, название проекта, выбрав в контекстном меню New 

Hyperlink Destination, мы увидим, что по умолчанию в типе назначения ссылки 

установлено Text Anchor. Оставим это без изменений, как и имя вновь создаваемого 

пункта назначения, после чего нажмем кнопку ОK. Снова выделим адрес сайта 

www.polylab.org, нажмем внизу палитры Hyperlinks кнопку New Hyperlink, выберем 

Text Anchor в качестве типа ссылки. Практически ничего не изменилось по сравнению 

с прошлым разом, но теперь в списке Text Anchor мы можем выбрать тот текстовый 

якорь, который только что создали. Таким образом, мы можем создавать текстовые 

якоря в качестве пунктов назначения для наших ссылок. 

Теперь давайте займемся созданием ссылок других типов. Для этого перейдем 

на вторую страницу нашей публикации, где внизу вы увидите адрес электронной почты 

дизайнера. Мы не будем заранее создавать для данной ссылки отдельный пункт 

назначения и сразу же, выделив e-mail, нажмем кнопку New Hyperlink. После этого 

поменяем тип ссылки на Email. В открывшихся свойствах в поле Address нужно ввести 

адрес, на который будет отправляться письмо по щелчку на эту ссылку, а в поле Subject 

Line — тема отправляемого письма. Опция (флажок) Shared Hyperlink Destination, как и 

ранее, отвечает за автоматическое создание пункта назначения, в данном случае для е-

mail. Давайте оставим ее включенной. Изменим стиль внешнего представления ссылки 

на Email, также ранее созданный в палитре Character Styles. После нажатия кнопки OK 

вы увидите, что цвет ссылки поменялся, а в палитре Hyperlinks появилась новая ссылка. 

Итак, мы попробовали создавать ссылки на URL-адреса и адреса e-mail. Теперь 

да вайте разберемся, как работают ссылки на страницы внутри документа и на 

страницы внешнего документа. До этого момента мы всегда создавали ссылки на 

основе текста. Однако InDesign не ограничивает нас этим. Мы также можем сделать 

ссылкой абсолютно любой фрейм (прямоугольная область, ограничивающая блок 

графической либо текстовой информации в InDesign) внутри нашего документа. 

Для начала, создадим новый пункт назначения на страницу нашего документа. 

Для этого через контекстное меню откроем диалоговое окно New Hyperlink Destination, 

в раскрывающемся списке Type удостоверимся, что выбран тип Page, в качестве 

назначения укажем десятую страницу, а в режиме масштабирования — Fit in Window 

(подогнать под размер окна), после чего нажмем кнопку OK. Откроем первую страницу 

нашей публикации и выделим фрейм, в котором находится надпись "Портфолио", 

после чего нажмем кнопку New Hyperlink. Далее выберем Shared Destination в качестве 

типа ссылки и Page 10 в раскрывающемся списке Name (рис. 1.20). 
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Рис. 1.20. Создание ссылки из графического объекта 

 

Для подтверждения нажмем кнопку OK. Как вы уже поняли, только что мы 

создали ссылку на страницу нашего документа, и, как подтверждение этому, обратите 

внимание на панель Hyperlinks. Рядом с вновь созданной ссылкой мы видим значок в 

виде листка бумаги, отличающийся от значков рядом с другими ссылками. Если теперь 

нажать кнопку GoToDestination (правая стрелка в нижней части панели Hyperlinks), то 

мы окажемся на десятой странице нашей публикации, чего мы и пытались добиться. 

К сожалению, при выборе в качестве источника ссылки фрейма, содержащего 

графический объект, меньший по размеру самого фрейма или отличающийся от него по 

форме, могут возникнуть некоторые проблемы. Для того чтобы их понять, вновь 

обратимся к первой странице нашей публикации. На ней вы видите наклонные 

объекты, стоящие очень близко друг к другу. Выделив по очереди несколько из них, вы 

обратите внимание на то, что фреймы, в которые они вписаны, на самом деле не только 

значительно отличаются по форме и габаритам от самих изображений, но и 

пересекаются друг с другом в некоторых местах. Предположим, что мы хотим сделать 

систему ссылок на основе этих изображений, каждое из которых переводило бы нас на 

соответствующую страницу портфолио. Здесь важно знать, что InDesign при работе с 

такого типа ссылками учитывает не форму самого изображения, а прямоугольную 

рамку вокруг него — так называемый Bounding Box или габаритный контейнер. Таким 

образом, создав ссылки из данных изображений, мы получим проблему, 

заключающуюся в том, что "чувствительные" к нажатию области ссылок будут 

пересекаться, что приведет к возникновению мест с непредсказуемым поведением во 

время нажатия. В связи с этим, будьте осторожны при создании гиперссылок, 

источником которых служат фреймы с графическими данными, и всегда 

дополнительно проверяйте возможность пересечения их областей действия. 

В данном разделе мы изучили весь спектр возможных видов гиперссылок, 

которые можно внедрять в интерактивный документ InDesign. В следующем разделе 
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мы поговорим, пожалуй, о самом значимом элементе при создании интерактивных 

документов — о кнопках. 

 

Контрольные вопросы: 

1. Опишите несколько способов изменения масштаба отображения 

документа. 

2. Как выбирать инструменты в программе InDesign? 

3. Опишите три способа отображения панелей. 

4. Как создать группу панелей? 

5. Как узнать о возможных проблемах вывода макета? 

6. Какой инструмент позволяет создавать текстовые фреймы? 

7. Какой инструмент позволяет связывать текстовые фреймы? 

8. Какой символ указывает, что текстовый фрейм вмещает больше текста, 

чем может отобразить (т. с. содержит вытесненный текст)? 

9. Какой инструмент позволяет работать как с фреймами, так и 

графическими объектами внутри них? 

10.  Какая панель предоставляет возможности для изменения выделенных 

фреймов, графических объектов или текста? 

 

Литература: [1— С. 25-43; 2 — С. 74-103; 3 — С.143-161; 4 — С. 250-281] 

 

Тема 3. Создание кнопок для системы постраничной навигации. 

 

1. Обзор возможностей работы с кнопками и интерактивными формами.  

2. Создание кнопок для системы постраничной навигации.  

3. Создание невидимых кнопок для реализации функций "всплывания". 

4.  Работа с интерактивными формами. 

 

Обзор возможностей работы с кнопками и интерактивными формами 

В предыдущем разделе мы говорили о том, каким образом в InDesign 

осуществляется работа с гиперссылками, рассмотрели их различные типы и 

проанализировали, для чего они необходимы. В этом же разделе мы познакомимся со 

спецификой и методами работы с одним из самых важных элементов интерактивного 

документа — кнопками в InDesign. 

Все взаимодействие с кнопками, их создание, удаление, редактирование, 

приданиеим различных свойств и визуальных эффектов — все это и много другое 

делается в InDesign CS6 через палитру Buttons and Forms, вызываемую с помощью 

меню Window > Interactive > Buttons and Forms (рис. 1.21). 

http://lib.lgaki.info/page_lib.php?docid=18176&mode=DocBibRecord
http://lib.lgaki.info/page_lib.php?docid=35232&mode=DocBibRecord
http://lib.lgaki.info/page_lib.php?docid=35291&mode=DocBibRecord
http://lib.lgaki.info/page_lib.php?docid=35223&mode=DocBibRecord
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Рис. 1.21. Вид палитры Buttons and Forms 

 

При открытии палитры вы можете обратить внимание на то, что практически все 

функции в ней не активны. Все это потому, что в настоящий момент на нашей рабочей 

области не выделен ни один объект. 

Давайте сначала поговорим про то, что, собственно, такое кнопки. Любая 

кнопка, по сути, это некоторый катализатор, вызывающий возникновение какого-либо 

действия или ряда действий. В InDesign мы можем создавать кнопку из любого фрейма, 

или группы фреймов, будь то графические, текстовые или вообще пустые. На второй 

странице нашей публикации в правом нижнем углу вы можете обнаружить 

графический векторный объект, состоящий из двух окружностей разных цветов, 

наложенных друг на друга. Давайте попробуем из этого объекта создать нашу первую 

кнопку. 

Обратите внимание, что эти два круга не сгруппированы. В InDesign мы можем 

создать как одну кнопку за раз, так и несколько, просто выделив несколько объектов. 

Таким образом, если есть необходимость создать одну кнопку, все графические 

или текстовые объекты в ней должны быть объединены в одну группу. В 

противном же случае каждый из объектов станет самостоятельной кнопкой. 

Итак, для создания кнопки необходимо щелкнуть по значку Convert to Button, 

расположенному в нижней части палитры Buttons and Forms. Посмотрим, что 

произошло. Мы создали сразу же две кнопки, т. к. наш объект до сих пор не был 

сгруппирован. Если вы не видите никаких изменений, нажмите клавишу <W> или 

используйте пункт меню View > Screen Mode > SWF Preview для того, чтобы выйти из 

режима просмотра. Обратите также ваше внимание на особый вид рамки, 

обрамляющий кнопку в виде пунктирной линии, под которой находится сплошная. 

Если вы не видите эту рамку или специальный значок в виде кнопки в правом 

нижнем углу рамки, используйте пункт основного меню InDesign View > Extras > Show 

Frame Edges либо сочетание горячих клавиш <Ctrl>+<H>. Настоятельно рекомендуется 

всегда оставлять фрейм и данные значки видимыми в течение всей работы, т. к. они 

будут давать информацию о том, с каким типом объектов мы работаем. 

Вернемся к нашим кнопкам. Нам, на самом деле, не нужно сейчас создавать две 

отдельные кнопки, поэтому выберем пункт меню Edit > Undo или же используем 

сочетание горячих клавиш <Ctrl>+<Z> для того, чтобы отменить создание кнопки. 
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Теперь, до создания нашей кнопки, сгруппируем обе окружности посредством 

команды меню Object > Group либо же с помощью сочетания горячих клавиш 

<Ctrl>+<G>. После этого вновь нажмем кнопку Convert to Button (рис. 1.22). 

 

 
 

Рис. 1.22. Вид палитры Buttons and Forms после создания кнопки 

 

Как вы видите, в панели Appearance палитры Buttons and Forms также 

произошли некоторые изменения. Давайте поговорим об этой панели подробней. В 

данном случае Appearance можно понимать как внешний вид кнопки. У этой панели, 

как мы видим, есть три строки или три состояния. В настоящий момент создано только 

одно — Normal. Это стационарное положение кнопки, когда с ней не происходит 

никаких действий, и нет никаких "влияний" на нее. 

Давайте щелкнем по строке Rollover, т. е. наведение. Как вы видите, теперь у нас 

появилось еще одно состояние кнопки. Оно описывает внешний вид кнопки при 

условии попадания в ее область действия курсора мыши, проще говоря, при наведении 

на кнопку стрелки. Третье и последнее состояние, которое можно создать сейчас, это 

Click, т. е. щелчок. Как нетрудно догадаться из названия, оно описывает внешний вид 

кнопки при осуществлении щелчка мыши по ней. 

Каждое из вышеописанных состояний может быть модифицировано независимо 

друг от друга. Давайте перейдем к состоянию Rollover, выделим внутренний круг и 

поменяем его цвет. Как вы видите, в панели Appearance отразились изменения и 

коснулись они только лишь выбранного состояния, т. е. Rollover, все же остальные 

строки остались неизменными. Если вы будете переключаться между этими строками, 

то вы также увидите, что в рабочей области в зависимости от выбранного состояния 

будет отображаться только его внешнее представление. 
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Давайте теперь для состояния Click уже известным вам способом изменим цвет 

внутреннего круга на какой-нибудь третий. Таким образом, мы получили три 

различных состояния для этой кнопки (рис. 1.23). 

 

 
 

Рис. 1.23. Вид панели Appearance палитры Buttons and Forms  

после настройки внешнего вида кнопки 

 

Давайте перед тем, как мы перейдем к рассмотрению верхней части палитры 

Buttons and Forms, попробуем просмотреть то, что у нас получилось. Мы, конечно, 

можем сделать это, экспортировав наш проект в PDF или Flash, но это может занять у 

нас много времени. Для осуществления режима просмотра в InDesign существует 

другая функция — палитра SWF Preview. Для ее вызова обратимся к пункту основного 

меню InDesign Window > Interactive > SWF Preview (рис. 1.24). 

Рассмотрим эту палитру немного подробней. В правом нижнем углу здесь 

имеются три кнопки, отвечающие за режим просмотра. Если выбрана правая 

(соответствует сочетанию горячих клавиш <Ctrl>+<Alt>+<Shift>+<Enter>), включается 

режим просмотра всего документа. В случае, к примеру, нашего документа, в котором 

порядка десяти страниц, его загрузка может занять достаточно много времени. Поэтому 

существует центральная кнопка (сочетание горячих клавиш <Ctrl>+<Shift>+<Enter>), 

при нажатии на которую включается режим загрузки просмотра текущей страницы, что 

существенно уменьшает время ожидания. Однако если вы работаете с достаточно 

сложным документом, на каждой странице которого по несколько интерактивных 

элементов, при текущих манипуляциях бывает удобно просматривать только один 

конкретный элемент. Для этого и создана кнопка просмотра выделенного элемента, 

расположенная слева в этой группе. 
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Рис. 1.24. Вид палитры SWF Preview 

 

Теперь, если мы вернемся к публикации, убедимся, что выделена именно 

Play), расположенный в левом нижнем углу 

палитры SWF Preview, мы увидим нашу кнопку. Убедитесь, что при наведении и 

нажатии на нее она приобретает цвет, соответствующий ее состояниям, заданным в 

панели Appearance. 

Теперь, когда мы увидели, что все работает корректно, давайте вернемся к 

палитре Buttons and Forms и разберем еще ряд дополнительных опций. Когда кнопка 

создана и выделена, на месте создания новой кнопки появляется другая — Convert 

Button to Object, которая позволяет превратить кнопку обратно в объекты, т. е. 

разобрать ее. Причем внешний вид получаемых объектов определяется тем состоянием, 

которое было выбрано в момент нажатия в панели Appearance. Информация об 

остальных состояниях будет просто удалена. Для того чтобы попробовать это, 

выберите состояние Rollover и нажмите кнопку Convert Button to Object. После этого вы 

можете разгруппировать полученный объект с помощью меню Object >Ungroup или 

горячих клавиш <Shift>+<Ctrl>+<G> и удостовериться, что теперь это снова 

обыкновенные векторные окружности. 

Вернитесь к состоянию, когда этот объект был кнопкой, несколько раз нажав 

сочетание горячих клавиш <Ctrl>+<Z>. Мы также можем скрывать или отображать 

определенные состояния наших кнопок, нажимая значок в форме глаза в строке 

состояния панели Appearance. Если же вы хотите полностью удалить состояние, а не 

просто скрыть его, то выделите нужное и нажмите кнопку Delete optional state and its 

content в форме мусорного ведра в правом нижнем углу палитры Buttons and Forms. 
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Итак, разобравшись с тем, как управлять внешним представлением кнопок, 

давайте попробуем поработать над их функционалом. Чтобы вам было понятно 

устройство работы кнопок в InDesign, давайте разделим любую манипуляцию с 

интерактивными объектами на три основных составляющих: 

1. В каком объекте фиксируются события, т. е. с каким объектом идет работа. 

2. Вследствие чего происходит действие, т. е. какие события предшествуют 

действию. 

3. Какое действие или действия, собственно, происходят. 

Теперь обратимся к верхней части палитры Buttons and Forms. В первую 

очередь, дадим нашей кнопке имя — напишем в поле Name "test button" (рис. 1.25). Все 

имена для любых интерактивных функций или объектов рекомендуется давать с 

помощью латинских букв. Это наш первый пункт — то, в каком объекте будут 

фиксироваться события. 

 

 
 

Рис. 1.25. Список возможных событий в графе Event палитры Buttons and Forms 

 

После того как кнопка названа, обратимся к следующей строке, а точнее 

раскрывающемуся списку, который называется Event. Этот список указывает на то, что 

должно произойти с кнопкой для запуска ее действия, т. е. пункт 2. По умолчанию 

выбрано событие On Release or Tap, что означает совершить действие после того, как 

пользователь отпустит кнопку мыши (при этом курсор должен находиться над 

кнопкой) или нажмет на кнопку пальцем в случае использования сенсорного экрана. 

Обратите внимание, что кроме этого события в списке имеется очень похожее — On 

Click. В чем же их принципиальное отличие? 

Представьте, что вы, к примеру, находитесь на каком-либо сайте, находите 

нужную вам ссылку или кнопку и, наведя на нее маркер, уже нажимаете на кнопку 

мыши (событие On Click), но в последний момент решаете перейти по другой ссылке, 

отводите мышь с нее и отпускаете (событие On Release or Tap, но уже вне зоны 

действия кнопки). Как вы знаете, никаких действий не произойдет, т. к. в любых сис 

темах взаимодействия с пользователем разработчики дают им возможность в 

последний момент "передумать". В случае с On Click переход осуществлялся бы сразу 

же после щелчка, не дожидаясь момента отпускания кнопки мыши. В связи с этой 

особенностью всегда старайтесь для своих кнопок использовать действие On Release or 

Tap, если для другого нет особых причин. 

Обратимся снова к раскрывающемуся списку Event. Кроме вышеперечисленных, 

там есть еще ряд параметров. Это, в первую очередь, On Roll Over, из названия 

которого вам должно уже быть понятно, что это событие описывает наведение курсора 



27 

 

мыши на кнопку, и On Roll Off, отвечающее за обратный процесс, т. е. выход курсора 

из области действия кнопки. 

Две остальные опции, On Focus (PDF) и On Blur (PDF), являются достаточно 

специфическими и присущи только при сохранении публикации в формате PDF. 

Первая отвечает за состояние, когда с помощью клавиши <Tab> пользователь 

"попадает" на какой-либо элемент, такое состояние объекта называется "в фокусе", 

вторая же кнопка отвечает за обратное действие, т. е. когда фокус покидает конкретную 

кнопку. Оставим для нашей кнопки событие On Release or Tap. 

Итак, когда мы определились, вследствие какого события с кнопкой будет 

происходить то или иное действие, давайте перейдем к следующему этапу подготовки 

кнопки — формулировки того самого действия. Для этого обратимся к панели Actions 

или действиям, которые, как вы уже догадались, описывает пункт 3 нашего списка. 

Для того чтобы добавить какое-либо действие нашей кнопке, нужно нажать на 

кнопку Actions в виде плюса "+" в верхней части этой панели (рис. 1.26). Немаловажно, 

что мы можем добавлять не только одно действие, но и целую последовательность 

различных действий. Кроме того, InDesign дает возможность создавать действия для 

разных событий у одного объекта, например, по нажатию кнопки и по наведению на 

нее курсора могут быть созданы различные действия. 

Как вы видите, список действий кнопки достаточно обширен. Он разделен на 

три раздела. Первая группа действий может быть осуществлена и в PDF- и во Flash 

файлах. Вторая применима только во Flash-файлах, третья, соответственно, только в 

PDF. Для начала давайте выберем самое первое действие в списке: Go To Destination 

(перейти к пункту назначения). После его выбора нам станет доступен ряд 

дополнительных настроек. Во-первых, мы можем выбрать документ назначения. Во 

второй строке мы можем выбрать из списка, собственно, место, куда будет 

осуществляться переход. Как видите, здесь их достаточно много, но откуда они здесь 

взялись? На самом деле, все эти пункты назначения — не что иное, как закладки, 

которые мы с вами создали ранее, и если вы откроете палитру Bookmarks, то вы их там 

увидите. Последняя строка отвечает за настройки масштабирования и тоже вам 

знакома. Единственное изменение здесь по сравнению с тем, что мы уже видели — это 

пункт Inherit Zoom, что значит наследовать настройки масштабирования из текущего 

состояния документа. 

Для примера, установим в поле Destination палитры Buttons and Forms значение 

Work 01, а для Zoom укажем Fit in Window, поле Document оставим без изменений, т. к. 

мы продолжаем работать внутри одной публикации. 
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Рис. 1.26. Список возможных действий после нажатия кнопки Actions в виде плюса "+" 

палитры Buttons and Forms 

 

Теперь, после того как мы применили все настройки к нашей кнопке, можно 

посмотреть, что у нас получилось. Но не торопитесь открывать палитру SWF Preview. 

В данном случае, т. к. у нас имеет место переход между страницами, необходимо 

запустить просмотр всего проекта целиком. Для этого в палитре Buttons and Forms 

предусмотрена кнопка Preview Spread, расположенная в левом нижнем углу палитры 

(рис. 1.27), которая является быстрым способом запустить панель SWF Preview. 

 

 
 

Рис. 1.27. Кнопка Preview Spread в палитре Buttons and Forms 

 



29 

 

Нажмем ее и посмотрим на результат. На первой странице мы видим нашу 

кнопку. При наведении на нее она меняет цвет. Обязательно попробуйте нажать на нее 

и, отведя курсор, отпустить. Ничего не должно произойти. А вот если же нажать и 

отпустить кнопку мыши, пока курсор находится в области действия кнопки, мы 

переходим на последнюю страницу публикации. Поздравляю вас, мы 

запрограммировали первый интерактивный элемент. Впереди еще очень много нового, 

но те принципы, которые мы сейчас освоили, мы будем использовать на протяжении 

всей работы. Обязательно обратите внимание еще на одну немаловажную особенность. 

В нижней части палитры Buttons and Forms в разделе PDF Options мы в поле Description 

можем задать описание для кнопки, которое будет появляться при наведении на нее 

мыши в программе просмотра либо произноситься компьютером, если это 

специальным образом задать. Это необходимо для поддержки функций для людей с 

ограниченными способностями. Если ваша целевая аудитория включает данную группу 

людей, не забывайте об этой функции. 

 

Создание кнопок для системы постраничной навигации 

В прошлом разделе мы научились создавать простейшие кнопки в нашей 

интерактивной среде посредством палитры Buttons and Forms и проверять полученный 

результат с помощью палитры SWF Preview. В этом разделе мы займемся развитием 

этих навыков и создадим в нашей публикации систему постраничной навигации, т. е. 

набор кнопок для перехода к следующей и предыдущей странице. 

В первую очередь, давайте удалим созданную ранее кнопку, т. к. она нам больше 

не понадобится. После этого перейдите в палитру Layers и отобразите слой, который 

называется navigation bar. Обратите внимание в нижней части нашей публикации на 

появившиеся кнопки со стрелками; именно они и будут, в конечном итоге, 

реализовывать систему навигации. К ним мы очень скоро вернемся, а пока что давайте 

разберемся с мастер-страницами в нашей публикации. Если вы посмотрите в раздел с 

ними в палитре Pages, то увидите, что там находится три основных мастера (рис. 1.28). 

Давайте, в первую очередь, откроем мастер B-Navigation. Здесь внизу 

расположены две кнопки для перемещения на предыдущую страницу и на следующую 

соответственно. Если вы откроете один из мастеров A-Cover или С-Goodbye, то 

увидите, что они специально созданы для первой и последней страницы публикации, т. 

к. на них отсутствуют кнопки перехода на предыдущую страницу для первой и 

перехода на следующую для последней, соответственно. Не трудно догадаться, почему 

это сделано именно так — перед первой и после последней просто нет других страниц. 

Заметьте также, что оба мастера, и A и С, основаны на мастере B-Navigation. Это 

сделано путем нажатия правой кнопкой мыши на нужном мастере, затем выбором 

пункта из появившегося контекстного меню Master Option for <Название мастера>... и 

указанием в открывшемся диалоговом окне Master Options в раскрывающемся списке 

Based on Master имени родительского мастера (рис. 1.29). 
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Рис. 1.28. Вид палитры Pages c мастер-страницами 

 

 
 

Рис. 1.29. Вид диалогового окна Master Options 

 

Как вы можете увидеть, в мастерах A и С указан в этом списке B-Navigation. Это 

также указано рядом с названием мастера в палитре Pages в виде маленькой буквы B на 

значке мастера. 

Так как некоторые элементы на мастерах A и С унаследованы от родительского 

мастера, то с ними невозможно работать в своих мастерах. Для того чтобы это 

исправить, необходимо "поднять" эти элементы на уровень текущих мастеров. Для 

этого нужно, держа одновременно нажатыми клавиши <Ctrl>+<Shift>, щелкнуть по 

нужному нам элементу. 

Теперь, когда структура документа нам понятна, давайте вернемся к мастеру B-

Navigation и начнем создавать кнопки. Для начала выделите элемент, который станет 

кнопкой. Обратите внимание на то, что в "стопке" он лежит поверх всех остальных 

элементов. Это немаловажный момент для корректного отображения макета при 

сохранении в формате PDF. В этом формате все кнопки всегда отображаются поверх 

остальных элементов. Даже если в изначальном документе это было иначе, при 

сохранении кнопка обязательно окажется наверху. Всегда помните об этом при 

создании интерактивных элементов. 
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После того как элемент для кнопки выделен, откройте палитру Buttons and Forms 

и создайте из него кнопку. Также создайте кнопку из маленькой цветной стрелки рядом 

с планируемой кнопкой. Тем самым мы хотим сделать такое визуальное представление 

системы навигации, при котором при наведении курсора мыши на кнопку перехода на 

следующую либо предыдущую страницу отображались бы маленькие стрелки справа 

или слева от кнопок соответственно. 

Для маленькой цветной стрелки, которая уже стала кнопкой, укажите опцию 

Hidden Until Triggered в палитре Buttons and Forms. Эта опция (флажок) указывает на 

то, что кнопка при старте проекта будет скрыта и будет отображена только после того, 

как это будет указано специальной функцией по действию какого-либо другого 

элемента. Не пугайтесь, скоро все станет понятно. Сразу же дайте этой кнопке имя, к 

примеру PageNavNextRollover. Не ленитесь давать кнопкам осознанные имена, иначе 

вы рискуете запутаться в них, как только количество возрастет. 

Перейдите к основной кнопке и дайте ей имя PageNavNext для перехода на 

следующую страницу. После того как кнопки названы, займемся описанием их 

действий. По сути, все действия будет делать у нас кнопка PageNavNext, а 

PageNavNextRollover будет просто служить визуальной индикацией для нее. Поэтому 

выделите кнопку PageNavNext и на событие On Roll Over задайте действие Show/Hide 

Buttons and Forms. После этого внизу палитры появится панель Visibility с опциями 

отображения для всех кнопок, имеющихся в проекте (рис. 1.30). 

Для того чтобы менять эти настройки, можно щелкать по переключателю рядом 

с названием кнопки. При этом крестик " " означает, что в данном действии с этой 

кнопкой не будет происходить изменение состояния ее видимости, а открытый глаз 

" " будет указывать программе, что необходимо отобразить указанную кнопку. 

Перечеркнутый же глаз подскажет системе, что ту или иную кнопку нужно 

скрыть. Все предельно просто. Как вы уже поняли, нам нужно отобразить кнопку 

PageNavNextRollover. Для этого поставим рядом с ней открытый глаз. 

Теперь, раз у нас есть событие, вызывающее отображение стрелки, нужно 

предусмотреть и обратное, позволяющее нам скрыть указатель после того, как курсор 

мыши покинет область действия кнопки навигации. Для этого у этой же кнопки на 

событие On Roll Off зададим действие Show/Hide Buttons and Forms, в опциях которого 

укажем скрыть видимость у кнопки PageNavNextRollover. Теперь, чтобы проверить, как 

все работает, выделите обе кнопки и нажмите на кнопку просмотра. 

Как мы видим, по наведению на кнопку появляется стрелка, после того как 

курсор меняет позицию, стрелка пропадает. Прекрасно, именно этого мы и хотели 

добиться. После этого давайте придадим нашей кнопке основной функционал, для 

которого она создается, т. е. переход на следующую страницу публикации. Для этого 

зададим на событие On Release or Tap (почему именно это событие, а не On Click, 

подробно обсуждалось в прошлом разделе) нашей навигационной кнопки действие 

GoToNextPage, т. е. перейти к следующей странице. У этого действия в качестве опций 

достаточно в поле Zoom указать Fit in Window для отображения вновь открывающейся 

страницы на все окно. Другие настройки у него отсутствуют. 
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Рис. 1.30. Настройки отображения кнопок  

по действию Show/Hide Buttons and Forms в палитре Buttons and Forms 

 

Далее проделайте те же самые действия с кнопкой возврата к предыдущей 

странице за одним исключением. На событие On Release or Tap необходимо задать 

действие Go To Previous Page, т. е. перейти на предыдущую страницу. Ну и, конечно 

же, не забывайте именовать свои кнопки, PageNavPrev и PageNavPrevRollover, к 

примеру. Когда мы создали кнопки для постраничного перехода вперед и назад по 

документу, давайте проверим, что на других мастерах все кнопки отображаются 

правильно. 

Кажется, при изменениях, которые мы сделали, у нас на мастерах из 

родительского мастера перезаписались лишние кнопки. Попробуйте выделить их, 

удерживая клавиши <Ctrl>+<Shift> и щелкнув по ним. К сожалению, ничего не 

получается. Здесь мы сталкиваемся с одной интересной особенностью InDesign. 

Возможно, это даже можно отнести к ошибкам в программе. Чтобы исправить эту 

ситуацию, нужно "перепривязать" дочерние мастера к родительскому. Для этого в 

каждом из мастеров А и C зайдите в диалоговое окно Master Option (как вы помните, 

это делается щелчком правой кнопки мыши по названию мастера и выбором 

соответствующего пункта из появившегося контекстного меню), в раскрывающемся 

списке Based on Master укажите None и нажмите кнопку OK. После этого снова зайдите 

в это диалоговое окно и верните значение списка Based on Master на B-Navigation. 

После осуществления этих процедур вы сможете выделить лишние элементы на 

дочерних мастерах (удерживая клавиши <Ctrr>+<Shift>) и удалить их. Теперь, когда 

все готово, можно посмотреть, что получилось, используя палитру SWF Preview и 

опцию просмотра всего документа целиком. 

 

Создание невидимых кнопок для реализации функций "всплывания" 

В прошлом разделе мы создали для нашего проекта систему навигации с 

реализацией постраничного перехода. Мы также научились работать с интерактивными 

элементами в составе мастер-страниц. Далее мы продолжим работу с такими 

элементами, как кнопки и, используя уже знакомую нам методику отображения и 

скрывания кнопок, разберемся с тем, для чего нам могут быть полезны прозрачные 

кнопки или прочие невидимые интерфейсные элементы электронной публикации. Для 
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начала, давайте перейдем на десятую страницу нашей публикации. Здесь вы можете 

увидеть карту, на которой имеются условные точки, обозначающие, в каких местах 

осуществлялся тот или иной проект фотографа. Давайте реализуем на этой странице 

такой интерактивный потенциал, при котором наведение пользователем мыши на один 

из этих кружков приводило бы к всплыванию "контекстного меню" с содержанием 

работы и ссылкой на соответствующую страницу нашей публикации (для того чтобы 

увидеть их заготовки, отобразите слой map rollover images нашего проекта). Подобного 

рода интерактивные элементы называются HotSpot. Но вы, к сожалению, не найдете в 

InDesign панели или функции, отвечающей за реализацию этой возможности, т. к. она 

также разрабатывается с помощью особого поведения кнопок. 

Давайте сделаем все по порядку. В первую очередь рассмотрим внимательней, 

что собой представляет эта карта. По сути, это набор векторных графических 

элементов, в данном случае окружностей. Так как InDesign в своей интерактивной 

части работает на базе векторных объектов, важно понимать, что, к примеру, кнопка, 

созданная из векторной окружности, будет иметь область действия, четко 

соответствующую этой окружности, не больше и не меньше. Для того чтобы понять, 

как будет выглядеть область действия у любой вашей вновь создаваемой кнопки, 

просто подведите к ней указатель мыши и вы увидите, в зависимости от слоя, на 

котором размещен элемент, обводку соответствующего цвета. Это-то и будет будущей 

областью влияния кнопки. В случае с нашим электронным изданием, на звание кнопок 

претендуют маленькие оранжевые круги (рис. 1.31). 

Попробуйте подвести к ним указатель мыши. Согласитесь, достаточно сложно 

даже попасть в них, не говоря уже о том, чтобы зафиксировать указатель и нажать на 

нее. Исходя из этого, логично было бы увеличить элементы, однако это может 

разрушить нашу дизайнерскую идею. Что ж, именно в таких ситуациях на помощь 

приходят невидимые кнопки или hotspot'ы. 

 

 
 

Рис. 1.31. Внешний вид заготовки для кнопки 

 

Для того чтобы создать подобный объект, выделим второй и третий 

всплывающие элементы и выберем из основного меню InDesign Object > Hide либо 

используем комбинацию горячих клавиш <Ctrl>+<H>. Работу продолжим с первым 

всплывающим блоком. Откроем панель Buttons and Forms и любым известным нам 

способом создадим из открытого блока кнопку и назовем ее, к примеру, MapImage1. 
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После этого слой со всплывающими панелями можно на какое-то время скрыть, чтобы 

он не мешал нам работать с другими элементами. Теперь выделите маленький кружок, 

соответствующий первому всплывающему блоку, и скопируйте его посредством 

команды меню Edit > Copy или с помощью горячих клавиш <Ctrl>+<C>. После того как 

вы это сделали, создайте новый слой над текущим (а так как выделен маленький круг, 

текущим слоем будет content). Назовем его, например, HotSpots и сразу же после 

создания расположим его над всеми слоями, т. е. на самом верху палитры Layers. После 

того как слой будет готов и помещен наверх, вставьте в него скопированную ранее 

окружность. Однако необходимо, чтобы она была помещена точно в то самое место, 

откуда была скопирована. Чтобы обеспечить это наиболее быстрым путем, выберите в 

основном меню пункт Edit > Paste in Place или используйте сочетание горячих клавиш 

<Ctrl>+<Shift>+<Alt>+<V>. 

Когда все готово, с помощью палитры Swatches присвойте вновь созданному 

кружку цвет None для заливки и обводки. После этого можно, с одновременно 

нажатыми клавишами <Shift> (пропорциональная трансформация) и <Alt> 

(трансформация из центра объекта), увеличить окружность в диаметре примерно в три-

четыре раза, как это вам покажется удобным (рис. 1.32). Теперь создадим из этого 

объекта кнопку с названием MapImageHotSpot1. 

 

 
 

Рис. 1.32. Форма и положение невидимой кнопки 

 

Не теряя времени, для этой кнопки на событие On Roll Over зададим действие 

Show/Hide Buttons and Forms с параметрами, делающими видимой кнопку MapImage1. 

На событие On Roll Off, соответственно, зададим обратное действие, т. е. скрыть 

кнопку MapImage1. Когда функционал для этой кнопки подготовлен, вновь отобразите 

слой map rollover images, а теперь немного поработаем с кнопкой MapImage1. В первую 

очередь, не забудьте установить у нее опцию Hidden Until Triggered. Давайте на этом 

этапе посмотрим, что у нас получилось — нажмем клавиши <Ctrl>+<Shift>+<Enter>. 

Как вы видите, наведение на нашу немного увеличенную область приводит к 

отображению панели и выглядит весьма естественно, несмотря на то, что она явно 

больше непосредственно кнопки. Но, как вы наверняка обратили внимание, стоит нам 

убрать указатель мыши с области действия и навести, скажем, на саму всплывающую 

панель, то она тут же пропадает. Это довольно просто исправить. Для этого достаточно 

просто задать у кнопки MapImage1 на событие On Roll Over действие Show/Hide 

Buttons and Forms с параметрами, отображающими ее саму, т. е. MapImage1, и на 

событие On Roll Off действие Show/Hide Buttons and Forms с параметрами, 

соответственно, скрывающими ее. Как бы странно это ни выглядело, если вы 

проверите, все будет работать четко и красиво. Теперь нам осталось только добавить на 

событие On Release or Tap этой кнопки действие по переходу на соответствующую 

страницу. Это можно сделать, добавив действие GoTo Page и указав номер страницы, 

на которую нужно осуществить переход. Поздравляю вас, вы создали свою первую 
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невидимую кнопку или HotSpot (рис. 1.33). Как видите, этот элемент существенно 

расширяет интерактивные возможности и дает широкий простор для творчества при 

создании электронных публикаций. Если вы хотите потренироваться в создании этих 

кнопок, повторите то же самое для всплывающих блоков 2 и 3. 

 

 
 

Рис. 1.33. Отображение всплывающего блока по наведению на невидимую кнопку 

 

Работа с интерактивными формами 

Начиная с версии CS6, в InDesign функции интерактивности значительно 

расширились, и к ним прибавилась возможность создавать сложные PDF-формы для 

заполнения. Для чего же они нужны? Представьте, к примеру, ситуацию, когда 

необходимо осуществить быстрый опрос среди сотрудников компании. Стандарт PDF 

дает для этого уникальные инструменты. Вам достаточно распространить среди них 

специально созданную форму, после заполнения которой им будет достаточно просто 

нажать на кнопку Submit или "Отправить", и она вместе с содержимым будет 

автоматически отправлена ее создателю, т. е. вам. Раньше для создания подобной 

формы требовалось использование пакета Adobe Acrobat Professional. Теперь же это 

элегантное решение получило развитие в InDesign. Давайте разберемся, каким образом 

можно создавать данные формы. 

Для начала работы откройте нашу рабочую публикацию на странице 

одиннадцать — здесь находится заготовка для нашей формы. Стоит обратить внимание 

на то, что для просмотра и тестирования нашей интерактивной формы нам обязательно 

будет нужен Adobe Acrobat. Если остальные интерактивные функции прекрасно 

работают в программах просмотра от сторонних производителей, то данная технология 

поддерживается только "родным" программным обеспечением Adobe. Палитра SWF 

Preview, как следует из ее названия, к сожалению, также не подходит для тестирования 

иных функций, кроме кнопок. 

В первую очередь, давайте обратимся к текстовым полям (рис. 1.34). То, что вы 

видите перед собой в заготовке — это обыкновенный прямоугольник, к которому 

применены заливка и обводка. С помощью пункта главного меню Object > Corner 

Options также внесены изменения в форму углов фрейма. 
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Рис. 1.34. Внешний вид элементов формы 

 

Для того чтобы превратить данный текстовый фрейм в поле для ввода, 

существует, помимо аналогичных способов, описанных ранее для кнопок, еще одна 

возможность. Просто щелкните по нему правой кнопкой мыши и в разделе Interactive 

появившегося контекстного меню выберите Convert to Text Field. 

При этом происходит автоматическое открытие палитры Buttons and Forms. 

Сейчас нам нет необходимости добавлять к данному полю какие-либо дополнительные 

действия, поэтому давайте просто экспортируем данный документ в PDF с помощью 

команды главного меню File > Export и выберем в нижней части открывшегося 

диалогового окна формат PDF (Interactive). Все опции экспорта можете оставить 

неизменными, о них мы поговорим чуть позже. Главное, необходимо проверить, что в 

разделе Forms and Media выбран пункт Include All. После этого можно нажать кнопку 

OK и посмотреть на результат. Как вы видите, цвет заливки и обводки сохранились, 

при этом форма была потеряна (рис. 1.35). Это происходит из-за того, что Acrobat пока 

не поддерживает отображение нестандартной формы у текстовых полей. Наверняка, в 

следующей версии мы увидим и эту возможность. А пока мы можем просто 

конвертировать данный объект обратно в простой текстовый фрейм, оставить его в 

качестве фона, а сверху наложить рабочее поле без заливки и обводки.  

 

 
 

Рис. 1.35. Вид элемента формы после экспорта 
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Точно так же как с кнопками, не забывайте давать всем интерактивным 

элементам, в том числе и полям, осознанные имена. Вы уже знаете, что впоследствии 

нам это пригодится. Если вы вновь откроете палитру Buttons and Forms, в ее разделе 

PDF Options существует ряд настроек, как раз созданных для регулирования поведения 

элементов на форме (рис. 1.36). В поле Description можно указать подсказку для 

пользователя, который будет работать с данной формой. Тогда, при наведении на 

объект курсора мыши, данная подсказка будет проявляться рядом с ним. 

Из опций, представленных далее, всего три идентичны для всех элементов и 

придают объекту на форме ряд свойств. 

• Printable — объект будет виден при печати формы. 

• Required — объект обязателен для заполнения или выбора. Без этого форма не 

сможет быть отправлена. 

• Read Only — придаст данному элементу статус "только для чтения", т. е. уста- 

новит запрет на его изменение. 

Для текстового поля существует три дополнительные опции. 

• Password — поле пароля, символы в котором отображаются при заполнении 

в виде звездочек. 

• Scrollable — определяет включение функции прокрутки при переполнении 

поля. 

• Multiline — позволяет создать поле, в котором будет несколько строк. В 

противном случае, весь текст в поле будет следовать одной непрерывной строкой. Еще 

одна настройка, которая здесь присутствует — Font Size — позволяет принудительно 

задать размер шрифта, которым будет выполняться заполнение. При этом из-за 

особенностей пользовательских настроек на каждом индивидуальном компьютере 

настоятельно рекомендуется для данной опции всегда устанавливать значение Auto. В 

противном случае, пользователь может просто не увидеть символы, которые он 

набирает в поле. 

Когда мы разобрались со всеми опциями, продублируйте создание текстовых 

полей с разнообразными настройками для всех остальных заготовок. 
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Рис. 1.36. Вид палитры Buttons and Forms при работе с текстовыми полями 

 

Теперь давайте перейдем к другому типу интерактивных элементов на форме — 

Check Box (кнопка-флажок с независимой фиксацией, установленное состояние обычно 

помечается "галочкой" либо "крестиком"). Объекты данного типа позволяют 

пользователю выбрать один или несколько пунктов из списка, представленного перед 

ними. Каждая из ячеек может быть выбрана или отключена. Для его создания можно в 

рабочей области нарисовать прямоугольники. Если теперь определить его с помощью 

раскрывающегося списка Type палитры Buttons and Forms как Check Box (рис. 1.37), то 

вы увидите, что в разделе Appearance, в отличие от трех положений у кнопки, здесь 

присутствует целых четыре — два для выключенного (сброшенного) состояния и два 

для выбранного или включенного (установленного). 
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Рис. 1.37. Вид палитры Buttons and Forms при работе с элементом Check Box 

 

Вы можете создавать разнообразные собственные дизайны для данного типа 

управляющих элементов или же воспользоваться контекстным меню палитры Buttons 

and Forms и, выбрав в нем пункт Sample Buttons and Forms, подобрать необходимый 

вид из уже готовых дизайн-решений. Еще один важный момент при работе с данным 

элементом заключается в том, что сам элемент Check Box и подпись рядом с ним на 

самом деле никак не связаны, поэтому, для того чтобы определить значение данного 

элемента, нам необходимо указать его в поле Button Value раздела PDF Options в 

палитре Buttons and Forms. Последняя нерассмотренная нами опция — Selected by 

default — определяет, будет ли данный Check Box включен по умолчанию при запуске 

формы. 

Следующий элемент, который может присутствовать на интерактивной форме 

— это Radio button или кнопка-переключатель с зависимой фиксацией для выбора 

единственного значения среди представленных. Методика ее создания немного 

отличается от того, что мы делали ранее. Для того чтобы InDesign "понимал", что все 

кнопки относятся к одной группе и пользователь может выбрать, в конечном счете, 

только один вариант, нужно сначала создать все макеты кнопок, после чего только 

определять их функционал. Как пример, создайте на рабочем поле четыре окружности, 

соответствующие четырем пунктам выбора. После этого, выделив их одно временно, 

определите их тип в палитре Buttons and Forms как Radio Button. Как вы видите, опции 

в разделе PDF Options совпадают с теми, что мы видели при работе с Check Box. 

Однако здесь имеется принципиальное отличие. Если ранее мы могли выбрать опцию 

Selected by default для каждого из элементов, здесь включение данной опции у одной 

кнопки автоматически отключает ее у всех других из одной группы (зависимая 

фиксация). 

Еще один интересный элемент в формах — Combo Box, позволяющий создавать 

раскрывающиеся списки значений. Для того чтобы снабдить его информацией, давайте 

выделим заготовку "Занимаемая должность" и определим ей тип Combo Box (рис. 1.38).  
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Рис. 1.38. Вид палитры Buttons and Forms при работе с элементом Combo Box 

 

В нижней части палитры Buttons and Forms вы увидите поле, в которое с 

помощью кнопки "+" (см. рис. 1.38) можно добавить элемент, название которого 

предварительно будет вписано в поле List Items. Кнопка "–" служит для удаления 

выделенного элемента. Здесь также присутствует новая опция (флажок) — Sort Items, 

которая, как вы, наверное, уже понимаете, сортирует значения в списке в алфавитном 

порядке. Если вы хотите, чтобы какое-либо значение выводилось по умолчанию, то при 

открытии формы просто выберите его в данном списке. Здесь же с помощью простого 

перетаскивания можно менять последовательность элементов. 

Следующий элемент, который мы рассмотрим, называется List Box (окно списка 

для выбора) и, по сути, повторяет функционал предыдущего за небольшим 

исключением. Дело в том, что List Box представляет собой поле, в котором 

одновременно отображаются все элементы из заданного списка. Кроме того, если мы 

включим опцию Multiple Selection, у пользователя появится возможность 

одновременного выделения нескольких элементов. Во всем остальном данный объект 

полностью идентичен элементу Combo Box. 

Последний важный интерактивный элемент, который InDesign позволяет нам 

внедрить, — это Signature Field или поле для цифровой подписи. По своему существу 

электронная подпись представляет собой реквизит электронного документа, 
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позволяющий установить отсутствие искажения информации в нем с момента 

формирования данной подписи и проверить принадлежность подписи владельцу 

сертификата соответствующего ключа. Более подробную информацию об электронных 

подписях можно узнать по ссылке http://www.digitalsign.ru/ или в любом другом 

источнике. 

Итак, когда мы разобрались с тем, как обеспечить форму элементами для 

заполне ния, давайте решим вопрос с дальнейшей работой с ней. Для решения данной 

задачи InDesign предлагает нам три действия для программирования кнопок. Первое — 

Clear Form — позволяет очистить нашу форму и привести ее состояние к тому, что 

было установлено по умолчанию. Второе — Print Form — позволяет распечатать 

форму; при этом учитываются те опции печати, которые мы задавали для каждого 

элемента. Наконец, последнее действие — Submit Form — как раз дает нам 

возможность обеспечить сбор данных форм от разных пользователей. Для этого мы 

можем либо указать URL-адрес специального web-приложения, которое собирает 

данные из них, либо просто указать наш электронный адрес (e-mail), на который данная 

форма будет отправлена в виде вложения, в следующей форме "mailto: ваш e-mail 

адрес". Данные возможности позволяют нам создать уникальные формы для сбора 

данных или для любых других целей и существенно расширяют наши интерактивные 

возможности при работе в InDesign CS6. 

 

Использование аудиофайлов в проекте 

В данном разделе мы научимся добавлять в наш проект аудиофайлы и 

настраивать для них разнообразные дополнительные опции, такие как, к примеру, 

управляющий компонент (виджет) и другие. Для того чтобы начать работу, отобразите 

слой Audio controllers в палитре Layers и перейдите на уже знакомый нам мастер B-

Navigation. В нем, в правом верхнем углу, вы обнаружите эскизы управляющих кнопок 

для аудиозаписей. В нашем случае на кнопку в форме треугольника мы будем 

закладывать функции запуска музыкальной композиции, на кнопку в форме квадрата 

— остановки воспроизведения. Окружность с ноткой внутри в качестве кнопки пока 

что использоваться не будет и будет просто служить пиктограммой, объясняющей 

предназначение рядом стоящих кнопок. Однако если вы хотите, то можете 

самостоятельно придумать для нее функцию, например смену музыкальной 

композиции. Итак, вернемся к кнопкам. Первое, что нам следует сделать при работе с 

мультимедийными композициями, к которым относятся в том числе и аудиофайлы, — 

это загрузить данные о файле в наш проект. Для этого наряду с использованием пункта 

главного меню InDesign File > Place, вы также можете использовать сочетание горячих 

клавиш <Ctrl>+<D>. В открывшемся окне выберите необходимый музыкальный файл, 

для нашей публикации это Music.mp3 из папки \Интерактивность нашей рабочей 

документации. InDesign CS6 воспринимает в качестве аудиофайлов только формат 

MP3. Если ваш файл находится в другом формате, то вам необходимо использовать 

отдельную программу для его конвертации. После нажатия кнопки Open вы заметите, 

что курсор изменит форму, и это будет означать, что вы все сделали верно, и теперь 

необходимо указать, на какое место следует вставить этот файл. Выберите любое место 

на листе и щелкните один раз мышью. После этого, для того чтобы соблюдать логику 

нашей слоевой структуры, переместите вставленный файл на слой content. Проверьте, 

что вы находитесь в режиме отображения Normal; для этого выберите пункт меню View 

> Display Mode > Normal или используйте горячую клавишу <W>. Когда вы это 

сделаете, обратите внимание на то, что область, ограничивающая только что 

вставленный аудиофайл, будет заполнена диагональной штриховкой (рис. 1.39). 
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Рис. 1.39. Отображение помещенного в проект музыкального файла 

 

Это означает, что эта область содержит в себе медиафайл. Значок в форме 

динамика в верхнем левом углу дает нам понять, что это медиафайл — аудиозапись. 

Когда мы будем работать с медиафайлами других типов, вы обязательно обратите 

внимание на изменение этого значка. При работе с любыми медиафайлами вы всегда 

должны держать в памяти, что они могут быть доступны для работы только в том 

случае, если расположены внутри рабочей области документа, т. е. в пределах листа. 

Причем, абсолютно не обязательно, чтобы весь фрейм попадал в эту область, 

достаточно просто, чтобы в ка ком-либо месте было их пересечение и больше 

половины фрейма находилось на листе. Соблюдая эти несложные правила, вы сможете 

избежать проблем, которые в дальнейшей работе может быть весьма сложно 

диагностировать. Так как мы работаем на мастер-странице, здесь вы также можете 

наблюдать преимущество использования наследования в мастерах. В случае с нашей 

рабочей публикацией вы можете, единожды внедрив медиафайл в родительский мастер 

(B-Navigation), автоматически получить его во всех дочерних мастерах (A-Cover, C-

Goodbye). Кроме удобства, используя подобную компоновку, мы можем избежать 

проблемы с одной параллельно играющей композицией, которая возникает при 

многократном помещении одного медиафайла на разные страницы или мастера. В 

качестве резюме запомните, что желательно всегда создавать компоновку мастер-

страниц проекта таким образом, чтобы не происходило дублирование какой-либо 

информации. После того как мы разобрались с медиафайлом, давайте вернемся к 

нашим кнопкам. Создадим из треугольной заготовки кнопку, которую назовем "Play". 

Тут же можно попрактиковаться в создании разных визуальных представлений кнопок. 

Давайте создадим такой макет состояния Rollover для данной кнопки, в котором 

изменим ее цвет на зеленый. Для этого щелкните по строке Rollover для создания 

нового состояния, после этого выделите кнопку и, перейдя в палитру Swatches, 

выберите зеленый цвет заливки. Давайте также создадим кнопку из квадрата и назовем 

ее "Stop". Не забудьте также изменить для ее положения Rollover цвет на красный. Это 

позволит нам достаточно интересно разнообразить внешний вид этих элементов 

управления. После того, как кнопки созданы, добавим им требуемый функционал. 

Начнем с кнопки Play. Зададим на событие On Release or Tap действие Sound. Вы 

должны были обратить внимание на то, что при выборе такого действия отобразился 

несколько другой набор элементов настроек. Первым из них является Sound — это имя 

того аудиофайла, с которым нужно произвести какие-либо действия, а 

раскрывающийся список Option позволяет эти самые действия выбрать. В первом 

раскрывающемся списке мы можем выбрать наш файл Music. В случае если бы ранее 

было загружено несколько медиафайлов, мы могли бы выбрать здесь любой из них. 

Теперь посмотрим, что нам предлагает раскрывающийся список Options (рис. 1.40). 
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Первый вариант, который мы можем выбрать — Play — отвечает за начало 

проигрывания композиции; второй — Stop — отвечает за остановку выбранной 

композиции; далее следует Pause — отвечает за временную приостановку 

проигрывания файла; Resume — отвечает за восстановление ранее приостановленной 

композиции; и, наконец, Stop All (SWF only) — отвечает за остановку всех играющих в 

данный момент композиций. Обратите внимание, что этот вариант доступен только для 

файлов, сохраняемых в формате SWF, т. е. Flash. Выберем для нашей кнопки Play 

соответствующую опцию из списка. То же самое проделаем с кнопкой Stop.  Теперь 

давайте снова обратим внимание на наш фрейм с медиасодержимым. При работе с ним 

может возникнуть еще одна трудность. При экспорте в формат PDF готовой 

публикации во время проигрывания музыки мы будем видеть наш медиафрейм, более 

того, внутри него появятся управляющие кнопки для работы с музыкой, заложенные по 

умолчанию в программе (рис. 1.41). Это не всегда удобно и часто мешает реализовать 

некоторые дизайнерские проекты. К сожалению, не существует возможности 

принудительно указать программе просмотра PDF не отображать эти управляющие 

элементы. Единственное, что мы можем сделать, — это попытаться скрыть этот фрейм 

средствами InDesign, что мы сейчас и попробуем сделать. 

 

 
 

Рис. 1.40. Вид палитры Buttons and Forms при работе с аудиофайлами 
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Рис. 1.41. Отображение управляющих элементов при проигрывании композиции в 

Adobe Acrobat Reader 

 

Для начала, выделив наш фрейм с аудиофайлом, давайте перейдем к новой 

панели Media. Чтобы отобразить ее, выберите в главном меню Window > Interactive > 

Media. Эта панель позволяет настраивать параметры для таких внедряемых элементов, 

как аудио- и видеофайлы (рис. 1.42). 

 

 
 

Рис. 1.42. Вид палитры Media при работе с аудиофайлами 

 

Для звуковых элементов предусмотрены следующие флажки для настройки: Play 

on Page Load, позволяющий запускать музыкальный файл сразу же при открытии 

страницы; Stop on Page Turn, указывающий, что нужно приостановить проигрывание 

при покидании пользователем данной страницы; Loop для включения цикличного 

воспроизведения композиции. Также здесь имеется раскрывающийся список Poster, 

который позволяет выбрать "заглушку" для того самого фрейма, о котором мы 

говорили ранее. Здесь представлены три основные опции. None означает отсутствие 

какого-либо наполнения, Standard — отображение значка в виде музыкального 
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динамика. Если же выбрать пункт Choose Image..., то нам в фрейме представится 

возможность выбрать в качестве изображения любую картинку с нашего диска (если 

размер картинки будет превышать размер фрейма, то она будет обрезана). Теперь, 

когда мы разобрались с параметрами панели Media, давайте вернемся к решению 

задачи со скрытием нашего фрейма. Если вы посмотрите на панель опций в верхней 

части экрана, то увидите, что сейчас он имеет размер 60×60 пикселов. Для того чтобы 

фрейма не было видно, уменьшим его так, чтобы его размер был меньше 1 пиксела. 

Теперь, когда мы будем нажимать кнопку Play, фрейм не будет виден. Еще она 

особенность заключается в том, что для первоначального проигрывания музыки нам 

всегда нужно будет нажимать на кнопку Play дважды — первый раз для загрузки файла 

и второй раз для выполнения команды Play. Это неудобство, к сожалению, никакими 

способами исправить не удастся. 

 

Контрольные вопросы 

1. Каковы преимущества добавления объектов на страницы-шаблоны? 

2. Как изменить схему нумерации страниц внутри документа? 

3. Как выделить элемент страницы-шаблона на странице документа? 

4. Какие преимущества в создании новой страницы-шаблоны на основе уже 

существующего шаблона? 

5. Когда для выделения объекта необходимо использовать инструмент 

Selection (Выделение), а когда - Direct Selection (Частичное выделение)? 

6.  Как изменить размер фрейма и его содержимого одновременно? 

7. Как повернуть графический объект во фрейме, не поворачивая сам 

фрейм? 

8. Как выделить объект внутри группы без разгруппирования объектов? 

 

Литература: [1— С. 43-64; 2 — С. 106-155; 3 — С.271-286; 4 — С. 374-379] 

 

 

Тема 4. Функции создания Multi-state Object. 

 

1. Палитра Multi-state Object.  

2. Создание галереи изображений с помощью Multi-state Object. 

3.  Использование палитры Object State. 

 

Функции создания Multi-state Object 

В данном разделе мы поговорим про создание и настройку объектов с 

множественными состояниями или Multi-state Objects и их использованием в 

интерактивной среде InDesign. Сразу хочу отметить, что данная функция, а также все 

последующие до конца этой главы применимы только для публикаций, 

экспортируемых в формат Flash. При использовании для сохранения формата PDF эти 

элементы работать не будут. Для начала работы давайте перейдем на страницу два уже 

хорошо знакомой вам публикации. Если вы выделите и переместите картинку в левой 

части листа, то увидите, что под ней располагается еще одна. На самом деле, здесь 

лежит несколько изображений для создания Multy-state Object. Что это за объекты, мы 

поймем в процессе их создания. Для создания и управления данным типом элементов 

используется палитра Object States, которую можно открыть, выбрав в главном меню 

пункт Window > Interactive > Object States. Нашей задачей будет являться создание 

своеобразного слайд-шоу. Мы попытаемся добиться такой функциональности, чтобы 

при нажатии на маленькую кнопку в форме ромба в нижней части листа происходила 

смена изображения и, кроме того, также менялась подпись к нему справа от этой 

http://lib.lgaki.info/page_lib.php?docid=18176&mode=DocBibRecord
http://lib.lgaki.info/page_lib.php?docid=35232&mode=DocBibRecord
http://lib.lgaki.info/page_lib.php?docid=35291&mode=DocBibRecord
http://lib.lgaki.info/page_lib.php?docid=35223&mode=DocBibRecord
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кнопки. Для того чтобы попробовать, как работает функция Multi-state Object, давайте 

выделим одно изображение и одну подпись и нажмем маленькую кнопку в форме листа 

в правом нижнем углу палитры Object States (рис. 1.48). Она называется Convert 

Selection to Multi-state Object и превращает выделенный объект или группу объектов в 

объект с множественными состояниями. Вы должны были обратить внимание на то, 

что вместо одного объекта, как мы задумывали, было создано два — один для 

изображения, один для подписи. Если мы хотим, чтобы этого не происходило, 

изображения и подписи нужно попарно сгруппировать. Нажмите клавиши <Ctrl>+<Z>, 

для того чтобы отменить предыдущее действие, и перейдитек палитре Layers. 

 

 
 

Рис. 1.48. Вид палитры Object States после создания первого объекта 

 

Вы найдете там слой под названием intro images/captions. В нем, как вы видите, 

находятся все изображения из этой стопки и все подписи к ним. Давайте, попарно 

выделяя их, объединим их все в группы так, чтобы каждому изображению 

соответствовала его подпись. После этого выделите все полученные группы и вновь 

нажмите кнопку Convert Selection to Multi-state Object. Кстати, кнопка слева от нее 

позволяет вставить в выделенное состояние скопированный ранее объект. Как вы 

видите, было создано шесть состояний, соответствующих своим группам из 

изображений и подписей к ним (рис. 1.49). В верхней части палитры мы видим поле 

Object Name, которое позволяет нам задать имя для вновь созданного объекта, к 

примеру "IntroImages". Таким образом, мы получили объект, который внутри себя 

содержит ряд определенных состояний, — это и есть Multi-state Object. Выбирая 

каждое из этих состояний, вы будете видеть, как они отображаются на вашем листе. 
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Рис. 1.49. Вид палитры Object States после создания всех объектов 

 

Теперь давайте немного поговорим про редактирование уже имеющихся 

состояний. Когда выделено какое-либо состояние (State n), к примеру, State 1, то вы 

можете, дважды щелкнув по какому-либо объекту, входящему в него, перевести его в 

состояние редактирования и теперь любые изменения, перемещения и т. д. будут 

сохраняться внутри записи о состоянии. Кроме того, если вам не нравится, как в 

настоящий момент названы наши состояния, то их можно в любой момент 

переименовать. Для этого следует трижды щелкнуть мышью по имени состояния State 

n. Наконец, чтобы вернуть любое из состояний в положение обычных объектов, тем 

самым исключив их из Multi-state Object, следует из контекстного меню палитры Object 

States выбрать пункт Release State to Objects для "освобождения" одного состояния либо 

же Release All States to Objects для всех состояний данного объекта. Не следует путать 

данный пункт с Delete State, при выборе которого состояние просто будет удалено 

вместе со всем содержимым. Также обратите внимание на опцию Hidden Until Trigered 

в этом меню, подобную такой же при работе с кнопками. Как вы помните, она 

позволяет скрыть объект до тех пор, пока он не будет принудительно отображен с 

помощью какого-либо действия. 

Теперь, когда объект со всеми внутренними состояниями создан и настроен, 

самое время заняться настройкой кнопки, которая будет управлять его поведением. Для 

этого преобразуйте заготовку в виде ромба в кнопку с именем IntroNextCaption и 

настройте для нее те параметры внешнего отображения, какие вы захотите. Кстати, 

если вы считаете, что данная кнопка слишком мала и неудобна для работы, то можете 

попрактиковаться в создании HotSpot. После этого на событие On Release or Tap 

задайте действие Go To Next State (IntroImages) (рис. 1.50). 
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Рис. 1.50. Вид палитры Buttons and Forms при работе Multi-state Object 

 

Для него в настройках существует всего две опции. Первая — Object — служит 

для выбора Multi-state Object, на который будет направлено действие, а вторая — Stop 

at Last State — включает режим, при котором при попадании на последнее состояние в 

объекте не будет перехода на первое, т. е. не будет происходить цикличный просмотр. 

Теперь все готово для того, чтобы просмотреть, что же у нас получилось. Попробуйте 

несколько раз нажать на созданную кнопку и посмотрите, что происходит. Обратите 

внимание, что изменяются не только картинки, но и подписи к ним. 

 

Создание галереи изображений с помощью Multi-state Object 

В предыдущем разделе мы научились создавать объекты с переменным 

состоянием. Теперь давайте попробуем применить их для какой-либо прикладной 

задачи, например, создания интерактивной галереи изображений. В первую очередь, 

перейдите к третьей странице нашей публикации и отобразите слой gallery images. 

Здесь вы увидите заготовку для этой галереи. В нашей работе мы будем добиваться 

такой функциональности, чтобы после щелчка по миниатюрам в левой части листа 

открывались полноценные изображения в правой. Кроме того, нужно предусмотреть 

возможность скрыть все изображения и вернуться к состоянию с пустым полем. Для 

этого в правом верхнем углу предусмотрена маленькая заготовка для кнопки в форме 

креста (рис. 1.51). 
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Рис. 1.51. Вид заготовки для галереи 

 

Итак, приступим. Во-первых, скройте слой gallery images. Когда вы это сделаете, 

то сможете увидеть, как должно выглядеть поле без изображений. После этого давайте 

вновь отобразим его и заблокируем слой content (нажмем значок замка на нем). Перед 

тем как создавать из изображений Multi-state Object, давайте перейдем на слой gallery 

images и нарисуем немного выше над изображениями прямоугольник без заливки и 

обводки (невидимый). Это нужно для того, чтобы создать такое состояние, в котором 

не отображалась бы ни одна картинка. Позже вы увидите, как это произойдет. Когда вы 

завершили с прямоугольником, выделите его вместе со всеми изображениями и в 

палитре Object States нажмите кнопку Convert Selection to Multi-state Object. Как вы 

видите, мы получили новый объект с набором состояний (рис. 1.52). Назовите его 

Gallery Previews. Обратите внимание на состояние State 1. Это и есть наш 

прямоугольник.  

 
 

Рис. 1.52. Промежуточный этап создания галереи 
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Переименуем его в null, чтобы было проще его идентифицировать. Так как он не 

видим, если мы выберем это состояние, вы увидите просто пустое поле, как мы и 

задумывали. Теперь осталось привязать миниатюры в левой части листа к вновь 

созданному Multi-state Object. 

Во-первых, создадим кнопку для отображения пустого поля или кнопку 

закрытия галереи. Для этого, как вы помните, у нас есть в правом верхнем углу 

специальная заготовка. Выделим ее и конвертируем в кнопку с названием GalleryClose. 

На самом деле, сейчас мы не будем задавать для нее какие-либо действия, т. к. они 

должны быть прописаны для каждого конкретного State. В противном случае, система 

работать не будет. Чтобы сделать это, сейчас просто вырежем эту кнопку с помощью 

комбинации горячих клавиш <Ctrl>+<X>. Теперь, переходя в каждое состояние State 

кроме null, вам просто требуется нажать кнопку Paste copied objects into selected State 

(кнопка со звездочкой в нижней части палитры Object States) (см. рис. 1.52). В каждом 

из состояний теперь останется только, выделив эту кнопку задать ей на событие On 

Release or Tap действие по переходу на состояние null в объекте Gallery Previews. Это 

делать мы уже умеем. Когда вы закончите, можно разблокировать слой content. 

Нам осталось только определить поведение по нажатию на каждую из 

миниатюр. 

Не сложно догадаться, что оно будет связано с событием On Release or Tap, в ре 

зультате которого будет происходить действие Go to State с указанием 

соответствующего состояния в Gallery Preview. После того, как все готово, давайте 

посмотрим, что же у нас получилось. По щелчку на каждую из миниатюр фактически 

отображается соответствующая картинка. Старайтесь обязательно проверять все 

возможные варианты работы пользователя с вашим продуктом. Например, сначала 

можно попробовать нажать все миниатюры по очереди и проверить, все ли картинки 

им соответствуют, потом логично проверить работоспособность кнопок Close на 

каждом изображении из галереи и т. д. 

Бывают ситуации, когда подобная проверка позволяет выявить небольшие 

ошибки и устранить их до передачи готовой работы заказчику. Когда вы закончили 

проверку, наша работа по созданию галереи завершена. Теперь вы понимаете для чего 

нужны Multi-state Objects, а также то, что в каждое состояние можно помещать не 

только изображения, но и другие интерактивные элементы. 

Это существенно расширяет диапазон наших возможностей при создании 

интерактивных публикаций. 

 

Контрольные вопросы 

1. Какой инструмент позволяет связывать текстовые фреймы? 

2. Как вызвать значок загружаемого текста? 

3. Что произойдет, если щелкнуть значком загружаемого текста между 

направляющих столбца? 

4. Какую клавишу нужно нажать, чтобы автоматически разделить 

текстовый фрейм на несколько связанных фреймов? 

5. Как называется функция, которая автоматически добавляет страницы и 

связывает текстовые фреймы для размещения всего импортированного 

текста? 
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